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Getting Started

In this section, you'll learn how to:

o Start and close applications

e Turn off the computer

GETTING STARTED 1



1. Turn on your computer.

Your screen should look like this:

@ Finder File Edit View Go Window Help <) wed 8:37PM

)
=3
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Tip: /f you see a login screen, type your Username and

password.

Back

/2 ~/

v

Mac OS X

Mac User

Password: |

@

Log In

You will be automatically logged in each time you restart your

computer.

GETTING STARTED
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Start and close applications

Start applications using Dock icons

1. On the Dock, click the @ icon.

@ Finder File Edit View Go Window Help 4)) Wed 8:37PM )

=

MACITTOS M LY

Tip: From here on, ‘click” means ‘click your left mouse button.”
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The iCal application should open, and look like this:

iCal File Edit Calendar View Window Help <) Wed 8:39PM @

e ical
2005 ' 10/9 @ 10/10  10/11 l!m!" 10/13  10/14 10/15
Home L

3 ("‘ Description

2 Al I

o I

11 |

Noon

2345678 ‘
5 b

16 17 18 19 20 21 22 _ |
23 24 25 26 27 28 29 o . | | . . L:
30 31 5

- [ «] pay [Week onth [ Q- Events & _\— -m/

EO@ eOwWRA¢ KW
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Close applications using Dock icons

1 . On the Menu Bairr, click iCal.

RN

iCGal File Edit Calendar View Window Help
e iCal —_—
| 2005 | 10/9 10/10 10/11 “10/121 10/13 10/14 10/15

o 8 AM | | ! | | | -
§ oa

o104

B 11.am

Noon

8 1p

H

= 2P

2 3456 7 8 ﬁ

910 11 12 13 14 15 ][

16 17 18 1920 2122 |
23242526272829 || 4y

~
A
b 4

K@seoLIEa

Hon

Descr
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2. When the menu appears, click Quit iCal.

@ B[=D File Edit Calendar View Window Help
About iCal iCal =
10/10  10/11 ' 10/12 *20/23Y 10/14  10/15
Preferences... 8, | |

Provide iCal Feedback
Register iCal

Services > |

Hide iCal 3 H
Hide Others
| __ShewAlt

Quit iCal

iCal should close and the Menu Bar should now read:

Finder

@ Finder Fil®) Edit View Go Window Help
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Practice

1. Open the iTunes application.

2. Close the iTunes application.

3. Open the Address Book application.
4

- Close the Address Book application.
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Start applications using the Finder

1.  Onthe Dock, click the ‘ﬁ icon.

/;@@@@&@@@1

The Finder window should open.

" Finder File Edit View Go Window Help 4) Thul3gspm @
— ==
000 & macuser : =

- J[al= o] & a

' @ Network E ﬁ @
| g Macintosh HD & :

Desktop Documents Library

'ﬁ
Q

& "
w
=
=
[=]
=

et

(= f —

kA macuser .@ “E L:E
1 B¢ Applications Movies Music Pictures
| =
{ ﬁ Documents :g g
ﬁ Movies k =
| Public Sites
é Music
B Pictures

8 items, 32.16 GB available —

ESESONIRQA -
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Tip: Note the Menu Bar now reads:

Finder

N

@ Finder File

Edit View Go Window Help

Desktop Documents LiH

Movies Music Pict
Public Sites

______ 8items, 32.16 GB available
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2. In the left window pane, click Applications.

= @ macuser =
= g
Documents Library
Music Pictures
2]
Public Sites

e 8 items, 32.16 GB available

More icons representing different applications should appear in
the right window pane.

| A Applications

AppleScript Automator

Calculator Chess Dashboard
g & (a

Dictionary DVD Player Font Book

iChat Image Capture

GETTING STARTED 11



Tip: Note the menu bar still reads.

Finder

@ Finder File Edit View Go Window Help

P _A Applications
<« »|[58{= m|| %%~ | Q
3- Double click the @ icon.
| A Applications
Q

[N

AppleScript Automator

¢
®

: ﬁ_q' macuser

| -/... = Applications Chess Dashboard

| ﬁ Documents
;\‘
H Movies

B Dictionary DVD Player Font Book
é Music B

i Pictures : @

ical iChat Image Capture

@0

©
€

24 items, 32.16 GB available

The calculator should open.
Tip: Note the menu bar now reads:
Calculator

RN

" Calculator Fjle Edit View Convert Speech Window Help
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Also, a small calculator appears on the Dock.

[ Desktop
fﬂ macuser

u/—-— = Applications

O OO Calculator

®

Dashboard

»

Font Book

@ Pictures ; ‘ﬂ
ni e

ical

meml
Dictiona
-
e
0

Image Capture

El
—
]
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Close applications using the Finder

1. On the Menu Bar, click Calculator, then click Quit Calculator.

File
About Calculator

Show All

E Desktop

B macuse

Edit

View Convert Speech Window Help

Hide Calculator 3H
Hide Others 3H

Applications
—
Q
© ¢
nternet Connect iSync iTy

)

® O O Calculator

0

1

(

The Calculator should disappear, and the Menu Bar should read

Finder again.

@ Finder File Edit

View Go Window Help

Tip: Nofe the Applications window remains open.

2. |Inthe Applications window, click the

®

button.

Ci?ej[“*

[l
W
¢

| A Applications

@ Network
e \ @,
i} Macintosh HD

E ﬁﬂ Documents
P
% Movies

—
>
(=1
o
=
m
v
v
w
o
=]
=

Calculator

Dictionary
é Music

AppleScript

<

Chess

=

®

DVD Player

Automator

@

Dashboard
W

[ 4
Font Book

$¢
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Practice

1.

Open System Preferences.

Tip: /s icon is on the Dock.

It should look like this:

@ System Preferences Edit View Window Help

<) Mon 10:07 AM

Internet & Network

@ e q =

Mac Network QuickTime Sharing
System
{1
R & @® §
Accounts Date & Time Software Speech
Update

Exposé Screen Saver
Hardware
J‘f - ) , -
(o - $ 7) =
CDs & DVDs Displays Energy Keyboard &  Print & Fax
Saver Mouse

Startup Disk

eeon System Preferences =
(<« » ][ showan | Qa \
.
Personal st 1Y
- - &
D & M I e
Appearance Dashboard & Desktop & Dock International  Security Spotlight

)

Sound

Universal
Access

KLOBOOLIDA: I W

Close System Preferences.

GETTING STARTED
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3. Open the iChat application.

Tip: Use the Finder.

— | A Applications

Calculator Chess Dashboard

%

Font Book

fe'

-

Image Capture

Internet Connect

=

-
g
-
B

1 of 24 selected, 32.16 GB available

4. Close the iChat application.
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Turn off the computer

1.

On the menu bar, click the . icon.

.

qki Finler File Edit View Go Window Help

When the menu appears, click Shut Down.

Finder File Edit

View Go Window Help

About This Mac
Software Update...
Mac OS X Software...

System Preferences...

Shut Down...

| Log Out Mac User...

Dock >
Location b
Recent Items [
Force Quit... LHD

- M—\
Restart...

{38

—

GETTING STARTED
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3. When the alert window appears asking if you are sure you want

to shut down, click the (€ shut Down button.

Are you sure you want to shut down your
computer now?

If you do nothing, the system will shut dow;
automatically in 1 minute and 54 secopds.

Conc @ )
~—_

18 GETTING STARTED



Practice: Getting Started

1. Turn on the computer.
- Open the Trash can.
- Close the Trash can.

- Open the Finder window.

- Open the Font book.

2

3

4

5. Under Applications, open the Calculator.
6

7. Close both applications.

8

. Close the Finder window.

GETTING STARTED 19
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Manipulating
Windows

In this section, you'll learn how to:

e Move windows

Minimize windows

Restore windows

Resize windows

Scroll through windows

Maximize windows

MANIPULATING WINDOWS 21



Move windows

22

1.

On the Menu Bar, click Help.

@ Finder File Edit View Go Window Hellp !

When the menu appears, click Mac Help.

.' Finder

File Edit View Go findow Qs

Mac Help 3#?

A

After the multi-colored disk stops spinning, the Mac Help window
should appear.

.' Help Viewer File Edit View Go Library Window Help <)

0006 Mac Help

[« »] (@~ Q- |

What's New in Tiger?
Check out great new features.

Discover Your Mac
Work smart, play hard.

Top Customer Issues
Connecting to the Internet
Remembering passwords
Switching from Windows
About your computer

A & 4 _
~n Mac OS HElp More topics...
Index
D A Look up topics easily.

MANIPULATING WINDOWS



4. Place the cursor on the Title Bar of the Mac Help window.

" Help Viewer File Edit View Go Library Window Help <)
—
006 Mac Help

N
(e A @)

5. Press and hold down the mouse button, then move your mouse

left.
@ Help vViewer File Edit View Go Library Window Help <) Mon10:35AM
‘
enoe Mac Help e

What's New in Tiger?
Check out great new features.

Discover Your Mac
Work smart, play hard.

Top Customer Issues
- Connecting to the Internet
2 INaNG el ® Remembering passwords
Switching from Windows
About your computer

A\ 54 .
P4 MaC OS Help More topics...
Index
www.apple.com Look up topics easily.

BN

KOBOOLIRA Y LW

The window should move left.

Tip: 7his /s also called “dragging,” as in, ‘drag the window left.”

MANIPULATING WINDOWS 23
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Release the mouse button.

Click the button in the Title Bar of the Mac Help window.

@ Help Viewer

View Go Library Window Help

<)

> Mac OS Help

www.apple.com

What's New in Tiger?

Check out great new features.

Discover Your Mac
Work smart, play hard.

Top Customer Issues
Connecting to the Internet
Remembering passwords
Switching from Windows
About your computer
More topics...

Index
Look up topics easily.

/4

This should close the window.

MANIPULATING WINDOWS




Practice

1. Open the Address Book application.

2. Drag the window to the bottom left of the Desktop.
3. Drag the window to the center of the Desktop.
4

. Close the window.

MANIPULATING WINDOWS 25



Minimize a window

1. On the Menu Bar, click Help.

2. When the menu appears, click Mac Help.

The Mac Help window should appear.

3. Click the @l button in the Title Bar of the Mac Help window.

699 \ Mac Help
[4 »Mv] Q- |

What's New in Tiger?
Check out great new features.

Discover Your Mac
Work smart, play hard.

Top Customer Issues
Connecting to the Internet
Remembering passwords
Switching from Windows
About your computer

.ﬁ‘ Mac OS He|p More topics...

Index
Look up topics easily.

www.apple.com
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The screen should now look like this:

@ Help Viewer File Edit View Go Library Window Help <)) Mon 10:40 AM @

MACITOSHD)

KOBOOLIRACY - W

=

o)
Tip: Nofe the Y icon that appears in the Dock.

KOEOOL DAy K-8

Leave the window in the Dock for the next task.
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Restore a window

28

1.  Inthe Dock, click the [£5

2.

e

icon.

K9BOOLIRAly X . W
~_ 7

The Mac Help window should now be the same size and in the
same place it was before you minimized it.

" Help Viewer File Edit View Go Library Window Help

<) Mon3:42PM @

) :'.-nl‘&. e -

. Mac OS Help

www.apple.com

066 Mac Help

What's New in Tiger?

Check out great new features.

Discover Your Mac
Work smart, play hard.

Top Customer Issues
Connecting to the Internet
Remembering passwords
Switching from Windows
About your computer
More topics...

Index
Look up topics easily.

MANIPULATING WINDOWS
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Practice

Open the Address Book application.

Minimize it.

Open the iCal application.

Minimize it.

From the Dock, restore the Address Book application.

From the Dock, restore the iCal application.

Close both applications.

Tip: Make sure the Menu Bar at the top of the screen reads

’

Finder next fo the c icon.

If it doesn’t, click on the application name, then click Quit.

“' Address Boo File Edit View Card Window Help
About Address Book
Preferences... 3,
Services [

Hide Address Book 3H
Hide Others ¥H

Quit Address Book #Q

A
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Resize a window

1. Open the Mac Help application.

2. Place the arrow on the slotted triangle in the bottom right corner
of the Mac Help window.

006 Mac Help
([« »][@-] Q-

What's New in Tiger?
Check out great new features.

Discover Your Mac
Work smart, play hard.

Top Customer Issues
Connecting to the Internet
Remembering passwords
Switching from Windows
About your computer

x Mac OS Help More topics...

Index
Look up topics easily.

www.apple.com

3. Press and hold down the mouse button.
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4. Drag upwards until the window won’t shrink any further.

®66 Mac Help
(&) &

e — What's New in Tiger?
: Check out great new features.

Discover Your Mac
Work smart, play hard.

5. Release your mouse button.

The Mac Help window should now be shorter.

O00 Mac Help

What's New in Tiger? [

Check out great new features.

Discover Your Mac
Work smart, play hard.

A
A4

Top Customer Issues :

MANIPULATING WINDOWS 31
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6. Place the arrow on the slotted triangle in the bottom right corner

of the window.

Mac Help

What's New in Tiger?

Discover Your Mac
Work smart, play hard.

Check out great new features.

|
|

7. Press and hold down the mouse button.

8. Drag your mouse to the left until the window won’t shrink any
further.
00606 Mac Help
CPe]) &

What's N
Check out g

Discover *
Work smart,
A

Top Custc”
)4 f»! A
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9. Release your mouse button.

The Mac Help window should now be narrower.

Keep this window open for the next task.
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Scroll in a window

1. Place your arrow over the vertical Scroll Bar of the Mac Help
window.

006 Mac Help '
CHE) & rL
What's ﬂ

Check out /

Discover ®
Work smart,
A

Top Custc”
)ai»! 2

2. Hold down the mouse button and drag downwards.

Discover
Work smart,

Top Cust
Connecting
Rememberi
Switching fri
About your

Y ur &
~ Mac OS Help More topicsi>

ey

This should drag the Scroll Bar down the window.

34 MANIPULATING WINDOWS



The contents at the bottom of the window should appear.

"6 06 Mac Help :
() & )
Connecting —
Rememberir
Switching fre
About your
A\v4

A/BAE].COS__HEI.F)\ More topics
Index

www.apple.com Look up top
A

v

Yy«

Keep this window open for the next task.
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Maximize a window

1. Click the [®] button in the Mac Help window.

Connecting
Rememberir
Switching fri
About your

\ Y/ :
~ Mac OS Help More topics

Index
www.apple.com Look up top
'

v

& B) )<Tvly

The window should take up the entire Desktop.

@ Help Viewer File Edit View Go Library Window Help <) Mon7:08PM
7606 Mac Help

(«»)(e-] a

What's New in Tiger?
Check out great new features.

Discover Your Mac
Work smart, play hard.

Top Customer Issues
Connecting to the Internet
Remembering passwords
Switching from Windows
About your computer

\ &4 .
~ Mac OS He]p More topics...
Index
e Look up topics easily.

KOs eOLIEa- W
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Click the button in the Title Bar of the Mac Help window.

-

e

Help Viewer

File Edit View Go

Library Window Help

Mac Help

<)) Mon7:08PM

Q-

\

> Mac 0S Help

www.apple.com

What's New in Tiger?
Check out great new features.

Discover Your Mac
Work smart, play hard.

Top Customer Issues
Connecting to the Internet
Remembering passwords
Switching from Windows
About your computer
More topics...

Index
Look up topics easily.

MANIPULATING WINDOWS
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Practice:
Manipulating Windows

38

1. Open the Mac Help window.
- Resize its window so it’s about 3 inches tall by 3 inches wide.
- Drag the window to the bottom left of the Desktop.

- Drag the window up to the top left of the screen.
. Minimize the window.

. Restore the window.

2
3
4
5. Scroll up and down the window to see its contents.
6
7
8. Maximize the window.

9

. Close the window.
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Working with
Documents

In this section, you'll learn how to:

Create documents
Save documents
Open documents
Copy and Paste
Cut

Delete

Print

WORKING WITH DOCUMENTS
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Create documents

1. Double click the 2 icon on the desktop.

View Go Window Help

eoulna:. ¥
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When the Macintosh HD window appears, open the
Applications folder.

8006

! Macintosh HD

(= o)lat

o

! @ Network
i | .
1 }l Macintosh HD

i E Desktop

{_?_]f macuser

[] ﬁ Applications

™ Documents

=
Y=
e

System

4 items, 32.16 GB available

_%:
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3. Double click the icon.

E— | A Applications _—

[« J[l= o[ %] OO

& #

& Internet Connect iSync iTunes

- w Q

E -

| Mail Preview QuickTime Player

E -

é =y

g Safari Stickies

|

| e "]

_ﬁ L d

: System Preferences TextEdit Utilities

S 24 items, 32,16 G8 available / —

Tip: You may have to move the window or scroll to see the icon.
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it

e 606 Untitled

Styles W!EEEE Spacing :] Lists :] b ¢ 4 ©
¥__r » > > > W
|DY T T I:l 1 T |2¥ L T I.;l 1 T | T 1 T I“K ) T T
|

The TextEdit window should open, with the cursor blinking inside

Tip: /f the cursor is not blinking inside the document, then click
the mouse button once inside the TextEdit window.

WORKING WITH DOCUMENTS
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4. Type:

Dear Dad,
® 006 Untitled
“styles %) (== = =) spacing I¥) [ Lists ) b ¢ 4 0

™ (l

[

¥ | 2 2 | 2

ID'Y'T'I'Il'I'I'I
Dear Dad|

2
T T T IE;I T T |4l T T

g
v
A

4

S. Press the ENTER key on your keyboard.

6. Press the ENTER key again to create a blank line.

7. Type:
Thanks for the new Macintosh computer you helped me pick
out.
® 006 Untitled
_Sty!es rv][EIE = =  Spacing rv] Lists -v] b ¢ 40
¥ |3 | 3 | 2 | 2 » | 2 |3 |3 | 2 » | 2 P w
log " " " Iy ! [ps syt e e e e e e
Dear Dad,

Thanks for the new Macintosh computer you helped me pick out|

8.  Pressthe ENTER key.

Keep this document open for the next task.
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Save documents

1.

On the Menu Bairr, click File.

| e TexgEdit Fiie Ediz Format Window Help |

eOoD— Untitled
Styles I:]EE = i)iSpacing giLists P_v-] > & 40 0Q
2 2 2 | 3

¥ | | | | |

lge = g ey e e et e e g
7 DearDad,

Edit Format Window Help

New #EN :
Open... #0
Open Recent > Q
—) 3 v 3 ) v
Close RN Is" " "7 lg
oAV Asi: ed me-fick out, N\
—SaveAll = — ,
iT
Revert to Saved
Show Properties 3P
Page Setup... 1 36P
Print... kP QuickT
S
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3. Inthe Save As field, type:

Thanks

=X
Save As: Thanks| / @

Where: | | % Documents )

|

.l

File Format: r Rich Text Format (RTF)

( Cancel ) (—Sa‘!e—)

Tip: Make sure Documents gppears in the Where box.

If it doesn’t click the down arrow next to the Where box, then
click Documents.

Save As: Thanks| 8

Wher¢ v | © Documents '

™ Network _
=4 Macintosh HD E—

{@® Desktop

& macuser

# Applications
& Documents

é Music
. [ Pictures ;
| T———— 000 |
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File extensions

The application automatically adds an extension at the end of the file
name.

For example, in the file name Thanks.rtf, .rtf is the extension that
TextEdit uses.

File extensions help the computer determine what application was
used to make a file. The file extension will be different depending on
the application you’re using.

Your computer may be set so it doesn’t show the extensions.

i ~ .
4. Click the .52 ) pution.

06 Untitled
Save As: Thanks| E]
Where: | | Documents ?]
File Format: | Rich Text Format (RTF) B
( Cam(el ) ( Save )
< R
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5- On the Menu Bairr, click File, then click Close.

Edit Format Window Help

A © 06

s

j Styles —1

[ Ry P
Thanks torﬂMed me pick out. N
L Save All T
Revert to Saved
Show Properties (3P q
Page Setup... 1 36P
Print... 3P QuickT
T —
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Open documents

1.

2.

On the Menu Bar, click File, then Open.

Window Help

Applications
Open Recent ‘Q
Save @
i Save All ) )
iSync iT
| Revert to Saved
: “ Desktop
. M Show Properties  "C3§P LN
i T macuser &
c 2 Page Setup... {r 36P >
! -/m = Application: Print... 36 P Preview QuickTi

In the Open window, click Thanks.

006 Open

f« » ! =107 [ Documents ) (Qsearch
V4 \

@ Network L Thiks
) Macintosh D

™

{E Desktop
@ macuser

/A Applications

li&g Movies
& Music
[ Pictures

Plain Text Encoding: | Automatic

9

[ lignore rich text commands

( Cancel ) Open
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r__ 5
Click the button.

4 Macintosh HD

& Desktop

2 macuser
/A Applications
liy Movies
& Music
I Pictures

00 Open
‘<« » ) [=im) 3 Documents B9 (Qsearch
™ Network B Thanks

Ao
08 g voa ke
londoedohin lide waa,
" i
n of
v

Name Thanks
Size 4 KB

<> ¢

Plain Text Encoding: | Automatic

B

__lIgnore rich text commands

C Cané@ Eopeny)

The document titled Thanks should open.

e 006 ‘e Thanks
(Styles v} (== = = [spacing |») Lists  |+) Ped0
S 2 S S S S S S S S S S S—

o

SIS el

S e

Dear Dad,

Thanks for the new Macintosh computer you helped me pick out.

Leave this document open.
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Practice

1. Open a new document.

2. In the blank window, type:

Dear Sis:

I’'m coming home next week. Let’s go to that movie you’ve
wanted to see. I'll be there Friday afternoon.

® 06 Untitled 2

Styles |v][§ = = =/ Spacing rVJ_Lists "] P& 40
¥ b b b I » 3 I 3 2 b 3 b -
lg " " " Iy TN Ty Ty T T Ry T T T e T g

Dear Sis:

I'm coming home next week. Let's go to that movie you've wanted to see. lll be
there Friday afternoon

3- Save the document as Dear Sis in the Documents folder.

4. Close the Dear Sis document.
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Copy and Paste

1. In the Thanks document, place the cursor at the end of this
sentence:

Thanks for the new Macintosh computer you helped me pick

out.

® 06 < Thanks

'~ Styles rv] [EIE = = Spacing -v] Lists -v] b ¢ 40
¥ |3 | 3 | 2 | 2 | 2 | 2 |3 |3 | 3 » 2 P w
lg """ " Iy TNy ! LY L lg W 77 Is ! lg
Dear Dad,

Thanks for the new Macintosh computer you helped ma

2. Click and hold down the mouse button, then drag back over the
sentence.

e o6 « Thanks

" Styles ;] [E" = = = spacing =) Lists :] b ¢ 4 0
| 2

L AN S N TN T N S S S S S S O
T T Ill T T Izl T lsl T T l.;l T T |5| T T IBI

v

IThanksf r the new Macintosh computer you helped me pick out.
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The sentence should be highlighted.

e o6 "2 Thanks

styles w) (== = =) spacing I¥) | Lists v) > e 40
¥ b » » » | 2 » » » » b » P -
lgr " " " Iy """l gttt g g
Dear Dad,

Thanks for the new Macintosh computer you helped me pick out.

On the Menu Bar, click Edit, then Copy.

TextEdit File . Format Window Help

.6 66 I<( T L;’ t

0

Dear Dad,

Thanks for the newl Paste =
Delete
Complete O
Select All A
Insert >
Find >
Spelling >
Speech >
Special Characters... 8T

In the document, place the cursor at the end of this sentence:

Thanks for the new Macintosh computer you helped me pick
out.

Then click the mouse button.

Press the ENTER key on your keyboard twice.
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6- On the Menu Bar, click Edit, then Paste.

TextEdit File d Format Window Help

Undo Typing ¥z
®66 Redo {r3eZ
(styles W) (= XXE)
L b Cut X —

Thanks for the new

o =% Copy ®C B " l¢ |
Dear Dad, Paste | B’V )
— Paste and Match Style {38V

Delete

| Complete X0
Select All #EA
Insert >
Find I>
Spelling >
Speech [>
Special Characters... 8T

You should now see two of the same sentence — the original,
and the copy.

® 606 . Thanks

Styles I} (== = = spacing )/ Lists iv) > e 40
L NN S N S S S S U U S —
lo T T T Il T T T Iz T T T ]3 T T T l4 T T T Is T T T IE T
Dear Dad,

Thanks for the new Macintosh computer you helped me pick out.

Thanks for the new Macintosh computer you helped me pick out|

7. Again, press the ENTER key on your keyboard twice.
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8. On the Menu Bar, click Edit, then Paste.

You should now see three of the same sentence — the original,
and two copies.

® 006 . Thanks

' Styles rv] [E

| =  Spacing -v] Lists "] P4+ 40
;2 S S S

L

3 » » I 3 b b P w
I | T e e e e e e e e e T e T e
Dear Dad,

Thanks for the new Macintosh computer you helped me pick out.
Thanks for the new Macintosh computer you helped me pick out.

Thanks for the new Macintosh computer you helped me pick out|

9. Save the document.

10. Quit TextEdit.
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Practice

1. Open TextEdit.

2. Open the document titled Dear Sis in the Documents folder.
3. Copy the paragraph 2 times below itself.

4. Delete the bottom paragraph.
S5

- Save the document as Peacocks.

Tip: ClickFile, then Save As.

Save As allows you to change a document and save it with a
new name. The original document will still exist with the old
name.

6. Close TextEdit.
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Open TextEdit.

On the Menu Bar, click File, then Open.

Open Recent

¥ 2

fg" "1 Close #EW
Save 38S
Save As... {r38S
Save All

Revert to Saved
Show Properties 3P

Page Setup... {r 3P
Print...
|

Window Help

i

kP

Click the file Thanks.

‘<« » ! !=im) 7 Documents

‘—H Q search

& Nework

3 Macintosh/ﬂﬁ

{{E Desktop

A macuser
A Applications
li#y Movies
& Music
| Pictures

o o\

Dear Sis
Peacocks

Thgks

Plain Text Encoding: | Automatic

<
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4. Click the [.9Pen ) putton.

006 Open

[ <> ‘ (= HE*] | Documents

[
L

@ Network ‘e Dear Sis
24 Macintosh HD ‘s Peacocks
{ Desktop
& macuser

/A Applications

§ Documents

ﬁ“" Movies

Musi Name Thanks
& Music Size 4 KB

:.d-b(

[y Pictures

Plain Text Encoding: ' Automatic H‘r—i

__lIgnore rich text commands

Z—
Caaned) Comeny )
N\

5. In the document, click at the end of the last sentence to place the
cursor there.
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While holding down the mouse button, drag back over the

sentence.

The sentence should be highlighted.

e 066 ‘s Thanks
Styles |w)[=I= = = spacing I¥) Lists iv) > e <o)
LA S S S S S T TR B T S —
IO T L T Il T 1 T Iz T L T ]3 T L T I4 T L T ]5 T L) IE T |
Dear Dad,
Thanks for the new Macintosh computer you helped me pick out.
Thanks for the new Macintosh computer you helped me pick out.
Thanks for the new Macintosh computer you helped me pick out.
On the Menu Bar, click Edit, then Cut.
|TextEdit File I:u Format Window Help
| UnCiO 3432 ! ~
eno | ner |
Styles - ‘& 40
£ 2N . 2
o AL Copy 3%C T g |
Dear Dad, ——Paste— =V
Thanks forthe new] Paste and Match Style {38V
Delete
Thanks for the new Complete AWV
Thanks for the new ~ Select All A
Insert [ 2
Find >
Spelling B
Speech B
Special Characters... NHT
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The last senten

ce should disappear.

® 006 . Thanks

"Styles |w)[=|= = = [ spacing I¥]/ Lists 'v) > e 40
P B I S S SR IR R BRI R
lo T L T ll T L T lz T L T l3 T L T l4 T L T ls T L T T
Dear Dad,

Thanks for the new Macintosh computer you helped me pick out.

< |

Wcinwsh computer you helpe

t.

Place the cursor in the blank line between the two sentences.

0006 . Thanks

styles  [¥) (== = =) spacing I¥) Lists  I+¥) > e 0
¥ | 2 | | |4 | 2 | 2 | 2 | | b b b ¥
I0 L I T I1 L] T l2 L) I L |3 L 1 L I4 T T lS L l6 T
Dear Dad,

Thanks

r the new Macintosh computer you helped me pick out.

ThanksAor the new Macintosh computer you helped me pick out.
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On the Menu Bar, click Edit, then Paste.

06

|TextEdit File I:ﬂ Format Window Help
Undo Cut ¥Z B

Redo

d
@@

Dear Dad,
Thanks for t

Thanks for the new

Paste and '-ﬁ"". tch Style

Select All
Insert

Find
Spelling
Speech

Special Characters...

Delete
Comp XD

{1362
e qo
e X
6

X{ v

IEA
| 2

>
>
>

€T

You should see three of the same sentence once again.

Leave the document open for the next task.

WORKING WITH DOCUMENTS

61



62

Delete

1.  Hignhlignt the last sentence.

2. Press the DELETE key on your keyboard.

The highlighted sentence should disappear.

3. Place the cursor after the word “Macintosh” in the last sentence.
9 O 6 . Thanks
Styls  |w) (== = =/ spacing I»)Lists |+ XERK
¥ | S S RN S S | 2 b -
NERERREE NEARAREE PERERRES NRARRRAE "R R l6
Dear Dad,

Thanks for the new Madintosh comper you helped me pick out.
Thanks for the new clntost{computr you helped me pick out.

4. Press the DELETE key on your keyboard.

One character will be deleted each time you press the DELETE

key.

L K R - WL - —
styles  [¥) (== = =) spacing I¥) Lists  I+¥) > e 4o
¥ | 2 | b |4 b | 2 | 2 | .4 b |4 b ¥
o " "y Ty Ty T s Ie
Dear Dad,

Thanks for the

ew Macintosh computer youtielped me pick out.
Thanks for the\new Macintoshcomputer you Helped me pick out.
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Tip: Delete does the same thing as Cut, except:
When you Cut something, you can Paste it later.
When you Delete something, you can’t paste it.

Keep this document open.
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Print

64

1.

On the Menu Bairr, click File, then Print.

\%m Edit Format Window Help
New 3N
®e66 Open... #0
styles § Open Recent » Jss ) IXXK)
¥ > B e e
I """ "7  Close £ A PR DR lg
Dear Dad, Save 38S
Thanks for tt Save As... ¢3S ed me pick out.
Thanks fortt  Save All 3d me pick out.
Revert to Saved
Show Properties 3P
Page Setup...
Print...
2. In the Print window, click the EZ225 9 button.
Printer: | psc 1200 series -4
Presets: | Standard *%
" Copies & Pages i
Copies: 1 gCollated
Pages: @ All
CFrom: 1 to: 1
® ( PDFv) (Preview) (Supplies...) ( Cance() (—HM-E)

The document should print.

3.
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4.

S.

Quit TextEdit.

You should see the Applications window.

@ Finder File Edit View Go Window Help

€) Tue 1:.06 PM &

i

—— | A Applications E =
X3 Q
| - ~—
© & ep
¥
Internet Connect iSync iTunes
L W Q
e
Mail Preview QuickTime Player
® &
Safari Sherlock Stickies
- PE —
i
A
System Preferences Utilities 3
— 1 of 24 selected, 32.16 GB available — 7

o 1 YIE] "Relwlc R

Close the Applications window.

= A Applications —_—
(Q

© © ]

\

Internet Connect iSync iTun

- W C
\ - m T

Mail Preview QuickTim

1L A T T N TR

~/-=— = Applications
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Practice:
Working with Documents

1. Open TextEdit.
2. Open the document Dear Sis in the Documents folder.

3. Copy the line:

I’'ll be there Friday afternoon.

and paste it 3 times below itself.

. Change the second instance of Friday to Saturday.

4

S. Change the third instance of Friday to Sunday.
6. Change the fourth instance of Friday to Monday.
7

. Save the document in the Documents folder as Schedule.

Tip: ClickFile, then Save As.

8. Close TextEdit.

0. Close the Applications window.
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Managing Files

In this section, you'll learn how to:

Open the Finder
Select a file

Copy afile

Create a folder

Select multiple files
Move files

Rename a file

Delete files and folders
Restore deleted items
Empty the Trash

Find files and folders

Burn files toa CD
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Open the Finder

What is the Finder?

The Finder is the application on your computer used to organize
folders and files.

Think of it as your computer’s filing cabinet.

1 = In the Dock, click the ‘1 icon.

(Pueowina:«

2. On the Menu Bairr, click View, then as Columns.

@ Finder File Edit Go Window Help
v as lcons i

eno as List

B3 EIE Q
Arrange By S "gi’ U
Hide Toolbar ET ‘
Customize Toolbar... Jcuments LiH
Hide Status Bar

e =
Show View Options ) ! é; ﬂ

Tip: 7he Finder can preview files in three ways: as lists,
columns, or icons.
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The finder should appear in Column view.

@ macuser =

@ Desktop
| Documents
[# Library

[® Movies

& Music

{2l Pictures
(@ Public

1 sites

Y Y Y YYTYVYY

B Documents
at
h Movies

n
8items, 32.16 GB available

3. In the left-most column, click Applications.

[@F Deskto
| ¥ Documents
|# Library

[® Movies

[ Music

|2l Pictures

¥FYVYVYVYTYVYY

I-" macuser

A Appli(*tions

Y
=) Documents
—

I
8 items, 32.16 GB available —
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A full list of your applications should be visible.

— | A Applications

| [0 AppleScript »
| & Automator

[l calculator

| & Chess

| @ Dashboard

| B Dictionary

| ['] ovD Player

| " Font Book

N ical

© O iChat

| i3 Image Capture
@ Internet Connect
B @ iSync

| & iTunes

| E Mail

| @& Preview

| € QuickTime Player

]
®
£
5
4 »

| & sherlock
= 24 items, 32.16 GB available

Leave the Finder window open for the next task.
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Select a file

1 . In the left-most column of the Finder window, click Documents.

| .. — - = gApp|icati°ns j-_

| [} calculator
| & Chess

| @ Dashboard
| B Dictionary
|| ovD Player

% Preview
| @ QuickTime Player .
v
| & sherlock b
Z B 24 items, 32.16 GB available e

| Documents —_—

|
|
-
=

TEE TR

O T T T

1
4 items, 32.16 GB available - —
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4.

Click the document titled Thanks.

Tip: 7he Preview column gives information about the document.

e 00 |+ Doguments -
[« )5 =[0) 5] = o \

@ . " « Dear Sis ¥ Preview:
il « Peacocks
A

ﬁl{' macuser m
fl‘% Applications

« Schedule

Name Thanks

Kind Rich Text Format
(RTF) document

Size 4 KB on disk
Created Yesterday at

8:17 PM
é Music Modified Today at 1:05 PM

. Last opened Today at 1:05 PM
| _|l Pictures

More info...

1 of 4 se¥ected, 32.16 GB available / /j/{

~_

Double-click the document to open it in TextEdit.

The document should open.

e o6 "2 Thanks

Styles |w) == = = spacing I»)/ Lists v) > o 40
¥ | 4 | 2 | 2 | 2 2 | 2 | 2 | 2 » | 4 » | 2 4
ID' LI L Il' LI B LN L 3 ¥ LS e L]

o 7y | [ e e

pDear Dad,

Thanks for the new Macintosh computer you helped me pick out.
Thanks for the new Macintoshcomputer you helped me pick out.

Tip:s When you open a document, the application in which the
document was created will open automatically.

Quit TextEdit.
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S.

Leave the Finder window open.

The document titled Thanks should still be highlighted.

eno | Documents =) '
<[ =) ] >
Oreon L2222
=
E Desktop
ﬁq' macuser
A L Name Thanks
e
- . .ch; 4 KB on disk
E Movies Created ;les;e;:‘av at
é Music Modified Today at 1:05 PM
Last opened Today at 2:50 PM
m e More info...
lof4 selelclted. 32.16 GB available ﬁ
Tip: /f it isn’t highlighted, make sure Documents /in the left
column is highlighted.
Then click Thanks /n the next column.
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Copy afile

1. On the Menu Bar, click Edit, then Copy Thanks.

@ Finder File

View Go Window Help
Undo Move of “SF07lastOpened”

@ Network
| g Macintosh HD

Select All

Show Clipboard
Special Characters...

2. Within the Finder window, click in the blank white space in the
same column.

= | Documents
<« > Wa = Q
@ . , ' Dear Sis ¥ Preview:
A '« Peacocks

‘s Schedul

{.i_q' macuse, \ ' ) )
= Appli n
A pplicatigns Name Thanks

Kind Rich Text Format
(RTF) document

e Size 4 KB on disk
h Movies Created Yesterday at
117 PM
6 Music Modified Today at 1:05 PM

Last opened Today at 2:50 PM

More info...

n n
1 of 4 selected, 32.16 GB available
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This should deselect Thanks.

| Documents

"o Dear Sis
‘3 Peacocks

'« Schedu
e Thanks

@ Finder

File

View Go Window Help

Undo Move of “SFO7lastOpened”

Copy “Documents”

Paste item
Select All

Show Clipboz

Special Characters...

| 2. = (4

—

4~ |

| Documents

@ Network

g Macinto%

‘o Dear Sis
'J Peacocks
‘3 Schedule
s Thanks
. Thanks copy
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4. On the Menu Bair, click Edit, then Paste item.

The file should appear with the name Thanks copy 1.

800 S
€3 88 €1 Q
@ Network S Dear sis

‘e Peacocks
_ i "« Schedule

'« Thanks

—= Thanks copy
E Desktop < '« Thanks copy 1

5. In the left-most column of the Finder window, click Applications.
800 | Documents =)
4:«]1:: :.!m]j|nw| Q )

@ won || G0

= Macintosh HD : ;;:fi:'e

‘s Thanks copy
‘e Thanks copy 1

B

ﬁ Pictures

1l
6 items, 32.16 GB available 7
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On the Menu Bair, click Edit, then Paste item.

The Thanks file should appear in the list.

80006 |A Applications -
<« > [z =md{ -] Q )
@ Network @ Dashboard 8 |
B B Dictionary
El _i\'-- Macintosh HD {'] ovD Player
) % Font Book -
fin ical
u Desktop © ichat
M &2 Image Capture
[ macuser @ Internet Connect
=
-/um @ Applications % j‘sl'::lces
T\“i Documents "; :dail.
- review
1 ﬁ Movies @ QuickTime Player
& Safari
& Music &> sherlock
E| i }] Picture “ System Preference !
7 TextEdit <
'3 Thanks 3
i [ utilities >

25 items, 32.16 GB available

Tip: You may have to scroll down to see it.
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Practice

1. Locate the file Dear Sis.

Tip: /t's located in the Documents folder.

2. Copy the file.

3. Paste the file in the Documents folder.
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Create a folder

1.  Inthe Finder window, click Documents.

e i | A Applications — ()
» | 22 =[md | 2%~ Q

@ Dashboard
B Dictionary
" DVD Player
% Font Book -
fih ical !
© iChat

&2 Image Capture
@ Internet Connect
& isync

ae~ynes

& Mail

% Prevfew
QuickTime Player

@ safari
£ sherlock
< Stickies
¢ System Preferences JL
-/ TextEdit ) {
"« Thanks v
[ utilities >

25 items, 32.16 GB available

i. l macuser
|

.z R
7T Appltauuns

2.  Onthe Menu Bar, click File, then New Folder.

@ Finder Jill Edit View Go Window Help

New Finder Window €N
) O ew Folde (r 36 ocument
< » || o New Smart Folder 3N Q
= = New Burn Folder
@ Network Open %0
. Open With B
_iig Macintosh ~ Print
~ Close Window EW
u Desktop | Get Info 38l
(§ | macuser Duplicate ¥D
Make Alias 8L
7/ Applicatia  Show Original 3R
Add to Favorites 8T
- - Create Archive of “Documents”
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A new folder should appear inside the Documents folder.

The name of the folder, untitled folder, should be highlighted.

3 E Desktop

{ﬁ macuse

f/éf Applications

\

o\ o

anks copy
Thanks copy 1
|~ untitled folder

W

P20 | Documents
N« > | 2z =[md| %] ——
‘s Dear Sis
L @ Network B Dear Sis copy
P LT
| . Thanks

Type:
MyFiles
800 [~ untitled folder

[« » |{s2 =im] | 2%~ |

@ "« Dear Sis

L Ll "« Dear Sis copy
! ?_g Macintosh HD ~ :ﬁ:ﬁ;tﬁ:
‘|| s Thanks

d E Desktop

(j‘} macuser;

g A Applications

\

» 111177/

; Thanks copy 1
|7 'MyFiles|
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Press the ENTER key on your keyboard.

The name of the folder has now been changed to MyFiles.

It should move to its alphabetical place in the list.

800 [ MyFiles =)
oo 3 \
[‘1 h][--=ﬂ]]|['ﬂ-v] y
. ‘5_.' Neowork ‘'« Dear Sis copy
=
i) Macintosh HD : i
1 u Desktop
(&4 '« Thanks copy
i 1§ macuser '3 Thanks copy 1
" A Applications
.
r’.\‘ Documents
; st . £
1 é Music
| [T Pictures
|
1 1]
0 items, 32.16 GB available //,
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Select multiple files

82

1.

Hold down the SHIFT key on your keyboard.

Then, in the Documents window, click on the first and last
Thanks documents.

| Documents

[== = fmd | - |

‘e Dear Sis

"4 Dear Sis copy
[ MyFiles
~ Peacocks

"« Schedule

B Thanks

"« Thanks copy
e Thanks*opy 1

¥ Preview:

Name Thanks

Kind Rich Text Format
(RTF) document

| Documents
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‘< Dear Sis copy
[ MyFiles

'« Peacocks

"= Schedule

[ Thanks copy
[ Thanks copy 1




2.

Click in the blank white space below the folders in the Finder

window.
= | Documents
= (I { 2~ Q
| @ ‘s Dear Sis
i Network ’.‘ Dear Sis copy
| g Macintosh HD | [r-‘._,'f MyFies i
| '« Peacocks
| '3 Schedule
B Thanks
B Thanks copy
B Thanks conv 1
I
______ = 3 of 8 selected, 32.16 GB available
This should deselect the files
|1 Documents
) (-] o

.' @ Network

| g Macintosh HD |

: E Desktop
(_{"r macuser

| A Applications
-

| & Documents

‘s Dear Sis
"3 Dear Sis copy
(7 MyFiles

e

'« Peacocks

‘e Schedule

‘e Thanks

" Thanks copy
"« Thanks copy 1
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Hold down the Apple (or Command) key on your keyboard,
then select the first and last Thanks documents.

eoo | Documents

(e =In)( =) a
@ ‘e Dear Sis

| & Newwork "3 Dear Sis copy

[ MyFiles >

"« Thanks copy
B Thanks copy 1

{ ‘(j‘j macuser
1 A Applications
E |-~
e,
r‘ﬂ Documents

Click in the blank white space below the folders.

This should deselect the files.
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Move files

1.

2.

Click the Thanks file.

Holding down the mouse button, drag the Thanks file until it is
on top of the MyFiles folder.

o <« » {22 =[md( 25|

. Documents

E E Desktop
'(j.j macuser

g A Applications

?_é Macintosh HD

": Dear Sis
. Dear Sis copy

k MvFuh&
» Peagocks
‘= Schedule

"« Thanks copy
"« Thanks copy 1

¥ Preview:

Name Thanks

The folder should be highlighted, and you should see a ghost of
Thanks on top of it.

<« » {22 =[md( %]

| MyFiles

(j.j macuser
g A Applications

‘= Dear Sis copy

Y MyFiles >

« Peacocks
‘= Schedule
« Thanks

Thanks copy

Thanks copy 1

e
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3. Release the mouse button.

The file should now be located in the MyFiles folder instead of
the Documents folder.

800 [ MyFiles o |

(< )= =10 %) == e 3
@ '« Dear Sis ‘e Thanks

o L ‘e Dear Sis copy |

| & 1

i} Macintosh HD | =
E é acinte = Peacocks i

‘s Schedule

u Desktop '« Thanks copy
M ‘s Thanks copy 1
(g macuser |

E A Applications |
==

1 ﬁ Movies
é Music

E @ Pictures :
] |

n 1]
- 1item, 32.16 GB available -
Z

86 MANAGING FILES



Rename a file or folder

1.

2.

Click the Thanks file in the MyFiles folder.

After it has been selected, click on the name.

e O 0

]| 5|

« Dear Sis
'« Dear Sis copy
[ MyFiles
'« Peacocks
‘'« Schedule
« Thanks copy
« Thanks copy 1

7%_ Applications

vPre

Tip: /f you double click, it will open the file, so wait until the

name Is selected, then click.

You should see a highlighted box.

8006
[« » || 2 ={md{ £~ |

[ MyFiles

Q

« Dear Sis
‘'« Dear Sis copy
[ MyFiles
'« Peacocks
‘'« Schedule
« Thanks copy
« Thanks copy 1

7%_ Applications

w =
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3. Type:

Thanks renamed

[ MyFiles

r Sis

@ Network
g Macintosh HD

i ?‘k Schedule
"2 Thanks copy
"2 Thanks copy 1

'S | Thanks renamed| 'ﬁ

"4 Dear Sis copy K

4. Pressthe ENTER key.

The name should be changed.

Dear Sis B Thanks renamed
|| 3 Dear Sis copy
| L MyFiles

| '3 Peacocks

| '3 Schedule

|| '3 Thanks copy
|| '3 Thanks copy 1

[ 9
‘ Documents
—

ﬁ Movies

é Music

@ Pictures

—= [ MyFiles —_———

Name Thanks renamed
Kind Rich Text Format
(RTF) document
Size 4 KB on disk

Created Yesterday at
817 PM

Modified Today at 1:05 PM
Last opened Today at 2:50 PM

More info...

1 of 1 selected, 32.16 GB available
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Delete files and folders

1. Click the Thanks renamed file in the MyFiles folder.

Tip: Note that folders have right-facing arrows.

000 | MyFiles

[« ) =m)( %~ = ———,

@ « Dear Sis B Thanks renamed ¥ Pre
) Network '« Dear Sis copy

'é Macintosh HD | MyFiles

« Peacocks
« Schedule

E Desktop + Thanks copy
« Thanks copy 1

m r
m acuse

7%_ Applications
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2. Click and drag the file until it is on top of the a icon on the
Dock.

@ Finder File Edit View Go Window Help <) Tue4:31PM @
e 00 e | MyfFiles — =
<[ =m (-] a__
r' = Yo . H w.-. Dear Sis B Thanks renamed W Preview:
w et /| S Dear Sis copy
= | [ MyFiles

Macintosh HD | 5 Peacocks

‘s Schedule

's Thanks copy
s Thanks copy 1

ﬁj‘ macuser
7& Applications
L

&
. Documents

[TT SR TRTE Ar R e B

Name Thanks renamed
Kind Rich Text Format
(RTF) document
Size 4 KB on disk
Created Yesterday at
117 PM

Fiemel BUICRTITN |

edified Today at 1:05 PM
Last opgned Today at 2:50 PM

TN TN FEEE (L

ore info...

TR L EN A

i il I
1 of 1 selected, 32.16 GB available i 7

£K9BOOLITA: KB

3- Release the mouse button.

The file should be moved to the Trash.
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4.

S.

Click the MyFiles folder in the Documents folder.

{ = @MyFiies —]
| m B /_Q
@ Network .
e . .' MyFiles :
Q Macintosh HR_ {5550 70 =8 >
2 Thanks copy
‘3 Thanks copy 1
Click and drag the folder until it is on top of the i icon on the

Dock.

@ Finder File Edit View Go Window Help

<) Tued:32PM @

(X

[ MyFiles

R ) Dear Sis

"3 Dear Sis copy

® MmyFiles >
' Peacocks

'3 Schedule

| '3 Thanks copy

s Thanks copy 1

(81 3 ORI R N R O WL T T S R D K 'll[ll.ll.l]lil’.l!l.'l]li

0 items, 32.16 GB available

L UYL O] ¢ 1
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6. Release the mouse button.

The folder should be moved to the Trash.
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Restore deleted items

1.

Click the i icon.

Dj Pictures I]
I

6 items, 32.16 GB available 4

L Y

KEdEeowlnas éi

The Trash should open with the deleted files showing.

800 W Trash -

0= w](e-] a 3

— A I

| ©2% Macintosh HD Q f/j i
. . Thanks renamed MyFiles .

| m Desktop i
fiqr macuser

f& Applications
Jﬁﬁ Documents i
|4

| @ Pictures

| 2-‘ 3= - -
S items /_/é_‘
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3- Move the Trash window below the Finder window.

@ Finder File Edit View Go Window Help

<) Tued:36PM @

‘s Dear Sis
‘s Dear Sis copy
‘e Peacocks

"% Schedule

R Thanks copy
R Thanks copy 1

- - | - 5

~ W Trash =
b —
Thanks renamed MyFiles
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4.

Click and drag the folder named MyFiles back to the Documents
window.

<) Tue4:36PM @
—
e () Documents ——=— -~

C RO

@ "2 Dear Sis
Network

"% Dear Sis copy
E Macintosh HD

‘ Finder File Edit View Go Window Help

"3 Peacocks

"% Schedule

"3 Thanks copy
"% Thanks copy 1

7% Applications

@
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Click and drag the file named Thanks renamed back on top of
the MyFiles folder.

[ MyFiles -
)
'« Dear Sis
"» Dear Sis copy :
[ ]
= Peacoc
"3 Schedule
—o_Thanks copy
'« Thanks copy 1
]
L
E
f
k 1
| |
§ I 1l
0 items, 32.16 GB available _%j

Close the Trash window.
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Practice

1. Send the Thanks renamed and Thanks copy files to the Trash.
2. Locate the files Dear Sis and Dear Sis Copy.

3.  Select both files.

Tip: Hold down the SHIFT key on your keyboard.

4. Drag both files into the Trash.

MANAGING FILES 97



Empty the Trash

98

1.

Click the i icon on the Dock.

“0800LITa: LW

The Trash window will appear with all the contents listed.

Tip: You can drag a file out of trash to stop it from being
deleted.

On the Menu Bar, click Finder, then Empty Trash.

File Edit View Go Window Help

s

Documents

| Hide Finder 3H
H Hide Others C38H
P Show All
J_ *
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3.

In the window that asks Are you sure you want to remove the

items in the Trash permanently?, click the - button.

Are you sure you want to remove the items in the
A Trash permanently?
You cannot undo this action.

) @y

A

)

The contents of the Trash will be permanently deleted.

MANAGING FILES
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Find files and folders

1 . In the left-most column of the Finder window, click Macintosh
HD.
000 | Documents
[« > [ =img( 3] Q

L@ oo — & Myriles >
1 Network S~y Peacocks

— 2 xchedul
i} Magintosh HD 2 chedule
e k - anks copy 1

(_?} macuser

7= Applications

'_] Pictures

Il
4 items, 32.16 GB available

Tip: Clicking the hard drive icon tells the computer fo search the
entire hard drive. It will find documents meeting the search
criteria in any location on your computer.
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2. In the textbox with the magnifying glass, type:

dear

ELTNCa) Home

¥ HTML
E E custom-=-error.html.html| 10/27/04 12:48 PM
iv Documents
"e Peacocks Today at 7:08 AM
‘4 Schedule Today at 1:41 PM
‘4 Thanks Today at 2:53 PM
'3 Thanks copy 1 Today at 2:53 PM

Tip: /f you can’t remember the full name of a file, you can
search for part of the word. For example, dea will still find dear.
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Files that contain the word “dear” in them will appear under the
Documents folder.

+) Il

Computer “Volume “Macintosh H Other

—2) custom-errorhel.html 10/27/04 12:48 PM

5 ¥ Documents
'3 Peacocks
"4 Schedule
"4 Thanks

3 Thanks copy 1

Today at 7:08 AM
Today at 1:41 PM
Today at 2:53 PM
Today at 2:53 PM

Select an item to see its path.

5 items e ®

3. Close the Searching Computer window.

3 custom-error.html.html
' ¥ Documents

"9 Peacocks
Y Schedule Today a

h‘l’ Thanks Today 2
Today 2

"3 Thanks copy 1
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Burn filestoa CD

1.

Insert a blank CD-R disk into your computer.

A window should appear.

4 You inserted a blank CD. Choose an action
) from the pop-up menu or click Ignore.

Action: | & Open Finder o

I Make this action the default

® (Ignore) ( OK )

4 You inserted a blank CD. Choose an action
- O from the pop-up menu or click Ignore.

-»

Action: | K Open Finder f

I Make this action the default

@ Clrde) €D >

MANAGING FILES
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The icon should appear on your desktop with Untitled CD
under it.

@ Finder File Edit View Go Window Help 4) Tue7:37PM @

LESROOLIRA s (W
3. Double click the icon.

view Go Window Help ) Tue7:35PM @

IMacintos nyH D]
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The Finder window will open with the title Untitled CD.

The icon is highlighted at the bottom left.

@00 = Untitled CD =)
o« > Js8= m{ -] )
@ Network Recordable CD [ Burn N
i Q Macintosh HD
E Desktop j
f}j‘ macuser

|
0 items @:@

Right-click the Untitled CD icon.

MANAGING FILES 105



106

When the menu appears, click Rename Untitled CD.

: g Macintnsh HD D

Open
Get Info

Open Enclosing Folder
Eject

Automator

Disable Folder Actions
Configure Folder Actions...

K.M Attach a Folder Action...

Rename “Untitled CD"
Remove From Sidebar

[ Movies —movetoTrash

>

0 items

Type:

Assignments

in the Name field

Pictures

f
ﬁ Documents

; g Assignments| &3

0 items, 1.3 MB of 702.8 MB used on disc

Then press Enter.
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The icon on the Desktop should now read Assignments.

|View Go Window Help <) Tue7:40PM

9. In the Finder window, click Documents.

4 Assignments

Recordable CD
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1 0. Click the Schedule document.

12.

Peacocks

Thanks copy 1

4 items, 32.16 GB available

Schedule

Peacocks

i

i
®
al

Thanks copy 1

1 of 4 selected, 32.16 GB available

Release the mouse button.
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1 3. In the left-most column of the Finder window, click
Assignments.

| Documents —(

i @ Network
| S e =N

! é Macintosh HD | g &

' MyFiles Peacocks
: E Desktop

1 @ macuser

Thanks copy 1

Pictures
! ":;2, Assigr*m

ents &4

1 of 4 selected, 32.16 GB available

Schedule

| Q Assignments vv
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14. cCiickthe E icon located to the right of Assignments.

D

1 item, 1.3 MB of 702.8 MB used on disc

. 3
15. When the window appears, click the button.

Are you sure you want to burn the contents of
/ f) “Assignments” to a disc?

CDR You can use this disc on any Mac or Windows computer. To eject the
- disc without burning it, click Eject.

Disc Name: Assignments

ar

Burn Speed: ' 24x (faster)

1 Save Burn Folder To: Assignments

e G
(a.n(e\)(—-m....-,t >

The CD should burn.
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16. CcCiick and drag the icon to the Trash on the Dock.

@ Finder File Edit View Go Window Help <) Tue8:13PM @

Assignments

KBEOOW/nQA: a

The CD should eject from the computer.

1 7. Close the Finder window.
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Practice: Managing Files

1. Open the Finder window.

2. Make 2 copies of the Peacocks file in the Documents folder.
3. Rename one copy Fruit Trifle.

4. Create a new folder in the Documents folder called Recipes.
S5

. Move one Peacocks file and the Fruit Trifle file into the
Recipes folder.

6. Delete the Recipes folder and its contents.
7.  Minimize the Finder window.

8. Empty the Trash.
9

- Close all windows.
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Getting Help

In this section, you'll learn how to:

e Use the Help menu

* Get help for applications
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Use the Help menu

114

On the Menu Bar, click Help, then Mac Help.

@ Finder File Edit View Go Windoy

k Mac Help 387 )

In the Ask a Question field, type:

How do | print?

The Mac Help window should open.

®006
(« ][ &-]

Mac Help
Q- How do | print]

. Mac 0S Help

www.apple.com

What's New in Tiger?
Check out great new features.

Discover Your Mac
Work smart, play hard.

Top Customer Issues
Connecting to the Internet
Remembering passwords
Switching from Windows
About your computer
More topics...

Index
Look up topics easily.
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Press the ENTER key.

A list of Search Results should appear.

¥ It takes a long time for my document to print

~+ Using the Print dialog [
. Printing from Mac OS 9 applications [HRTRATAAARTORCATY
~+ Transferring pictures from a Windows computer (T
/. | try to print but nothing happens (R
~+ Sharing your printer with UNIX users via LPD/LPR (AR
~+. Sharing your printer with Windows users via SMB/CIFS (R
/. Setting up to print to a printer [
4. | can't add my printer to the Printer List (AR
/. Printing several pages of a document on a single sheet of p... [N
2+ The printer I'm adding says "Driver not installed" i
nmmmmmmmmm

__Installina and nndatina nrinter snftware

/e O 6 Search Results: How do | print?
[ 4 > ] [ 0t ~ ] Q- How do | print? 3)
Title Rank -
¥ Help Topics

Found: 25 help topics, 18 support articles E

Taln(

Click Using the Print dialog.

¥ Help Topics

¥ It takes a long time for my document to print
4+, Using the Print dialog

Printing from Mac O

2+ Transferring pictures from a Windows computer [HERARTANTRTRARrA
2 | try to print but nothing happens (NN AR
~+ Sharing your printer with UNIX users via LPD/LPR T
£+ Sharing your printer with Windows users via SMB/CIFS (AR R

/9 O 6 Search Results: How do | print? |
[1 >][ﬁ}v] ‘a- How do | print? )
Title Rank

GETTING HELP
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Click the [__Show ) pution.

0006 Search Results: How do | print?
[4 P][ G}'] 'Q~ How do | print? ))
Title Rank

¥ Help Topics

4. It takes a long time for my document to print

¥ Using the Print dialog

__Installina and nndatina nrinter snftware

Found: 25 help topics, 18 support articles

. Printing from Mac OS 9 applications [HRTRATAAARTORCATY

~+ Transferring pictures from a Windows computer (T

/. | try to print but nothing happens (R

~+ Sharing your printer with UNIX users via LPD/LPR (AR

~+. Sharing your printer with Windows users via SMB/CIFS (NIRRT AR

/. Setting up to print to a printer (T

~. | can't add my printer to the Printer List (N

/. Printing several pages of a document on a single sheet of p... [N

/. The printer I'm adding says "Driver not installed" (I
\d

(€ show )

VY

You should see more information about this topic in the lower

part of the window.

@06
(«»][&~]

Mac Help

[Q~ How do | print?

Mac Help

Index m

ﬁ Using the Print dialog

Use the Print dialog to choose a printer, select options for how you want a document
to print, and choose whether you want to preview your document, save it as a PDF, or
fax it.

1. Open the document you want to print.
Tip: If you want to change the document's page orientation, print to a different
paper size, or reduce or enlarge the printout of a document, choose File >
Page Setup.

2. Choose File > Print.

3. Choose the printer you want to use from the Printer pop-up menu. If you don't
see the printer you want to use, choose Add Printer.
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6.

In the lower part of the window, click the blue link:

Printing

.6 SNG) Mac Help

[4 r][ﬁvl Q- How do | print?

Mac Help Index

printing a document, you can save it as a "preset.” After choosing your options,
choose Save As from the Presets pop-up menu and type a name for the set of
options. If you want to use this set of options when you print a document,
choose its name from the Presets pop-up menu.

6. Click the appropriate button if you want to preview or print your document. If
you want to fax it or produce a PDF, choose an option from the PDF pop-up
menu.

The options available to you in the Print dialog depend on the application you're using
and the printer you choose from the Printer pop-up menu.

If you don't see options you expect to see for a specific printer, you may need to set
up your printer to display its special features.

See also

Prikting
Prink optio

Printer setup
Displaying a printer's special features when you print

—

N
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You should see more information about

this topic.

®006 Mac Help
[ <->A{ v

Q- How do | print?

Mac Help

Printing

Click a topic below.

Automatically handling paper tray errors
Automating your printing tasks

Changing your default printer

Connecting USB devices to your computer
Getting a printed report of PostScript errors
Getting the best quality when you print a PDF file
1 can't print from a Classic application

| don't see my printer in the Print dialog

| try to print but nothing happens

Installing optional packages from the Mac OS X install discs

It takes a long time for my document to print

Manually feeding the paper when you print

Index

*

4 >

NN

The Mac Help window should close.

GETTING HELP
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Get help for applications

1 . Click the ‘1 icon in the Dock.

LPBOOLIRA: LN

When the Finder window appears, click Applications.

2.

3- Double click the =

icon.
8o A Applications =
[« » |22]= m || %~ | Q )
3 ] - - —
@ Network iﬁ &
f;é" Macintosh HD Mail Preview QuickTime Player
u Desktop @ b _
(}j macuser A Y e
Safari eTteek Stickies
-/mf Applications
ﬁ Documents o e = | M
m e System Preferences Utilities
é Music
[EH Pictures B
L 'y
'Y
Thanks v
25 items, 32.16 GB available %
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4.

The TextEdit window should open, with the cursor blinking inside
it.

e 066 Untitled

" Styles Q[-EJE = =/ Spacing QfLists q ‘> ¢ 40
¥ » | 2 | 2 2 | 2 » » » » | 2 b b ¥
e Y

On the Menu Bar, click Help, then TextEdit Help.

" TextEdit File Edit Format

TextEdit Help p 367

Window [ty

GETTING HELP




In the Ask a Question area, type:

check spelling

re o6 TextEdit Help \ h
[ < > ] [ ' g ] Q- check spelling| ) )

What's New in TextEdit?

EXL e R A Check out great new features.
il Discover TextEdit
: '. m Write words. Write code. Write on.
-1 &

Solving Problems
Find the answers to common

- problems.
-/ TextEdit Help
Index
www.apple.com Look up topics easily.

W
Press the ENTER key.
A list of Search Results should appear.
(@06 Search Results: check spelling |
[ 4 > ] [ G~ ] Q~ check spelling
Title Rank

¥ Help Topics

@ Checking spelling

7/ Setting preferences for new documents AT

GETTING HELP
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In the lower part of the window, click Checking spelling.

9.

@ Checking soelling

Setting preftrences for new documents

re o6 Search Results: check spelling u
[ 4. > ] [ ' g ] Q- check spelling
Title Rank

Click the [C__Shew ) 1y stton.

Found: 2 help topics

T ]

ire o6 Search Results: check spelling )
[ < > ] [ N ] Q- check spelling
Title Rank
¥ Help Topics
@ Checking spelling
7/ Setting preferences for new documents (M

AN

You should see more information about this topic.

On the Menu Bairr, click File, then Close.
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10. The TextEdit Help window should close.
11. Quit TextEdit.

1 2. Close all windows.
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Practice: Getting Help
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1. Open the Mac Help window.

2. Get help information on burn a cd.

The screen should look like this:

¥ Help Topics
Y Creating CDs and DVDs using the Finder

/. About recording on a CD-R disc more than once

4, | see an error message when | try to burn a CD or DVD disc
2+l got an "unknown error” message while burning a CD or DV...
.. Creating and using a burn folder

4, Creating a CD formatted for MS-DOS (Windows)

2+ Burning a disk image on a CD or DVD with Disk Utility

4+ About creating your own CD or DVD discs

2. Disc burning options are dimmed or unavailable

4+ Types of CD and DVD media that you can burn

2, | can't burn files on my recordable CD or DVD disc

I need heln hurnina CNs ar NVN<

Found: 25 help topics, 16 support articles

.8 O 6 Search Results: burn a cd
[( r][ﬁv] Q~ burn a cd
Title Rank

U
(NIRRT
AR
L
(AR
U
T
(NIRRT
mmmmm

mmmmm
AR

€ —show—)
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Get help information on change sounds.

The screen should look like this:

'. ®006 Search Results: change sounds
[« »|[ @~ Q- change sounds
Title Rank

¥ Help Topics
. Changing the alert sound (AR
~+ Changing the sound input volume (AR
¥ Support Articles
© No sound from some applications, but system alert sounds pl...

© iSync doesn't sync with a Symbian OS phone after pairing

Found: 3 help topics, 2 support articles @

Close the Mac Help window.

GETTING HELP
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Customizing Your
System

In this section, you'll learn how to:

 Change the desktop

 Change the screensaver
 Add/remove items from the Dock
« Change the Dock

CUSTOMIZING YOUR SYSTEM
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Change desktop image

1 . On the Menu Bairr, click the . icon.

ﬁ Findér File Edit View Go Window Help

S —

2. When the Apple Menu appears, click System Preferences.

Finder File Edit View Go Window Help

About This Mac F

Software Update...
b ac OS X Software...

System Preferences... |
Dock >

[—Location 00
Recent Items >

Force Quit Finder {38

Sleep
Restart...
Shut Down...

Log Out Mac User... 1{3¥#Q
T
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The System Preferences window should open.

e6on System Preferences
[« » ][ showan | a
Personal
[ EE E /,\
B B B o @

Appearance Dashboard & Desktop & Dock International Security Spotlight
Exposé Screen Saver

Hardware
£ (==  x) =
5 B 9 © = A4
\ = 5 C/ |
CDs & DVDs Displays Energy Keyboard &  Print & Fax Sound

Saver Mouse

Internet & Network

® 6 a @

Network QuickTime Sharing

System

i |

L !

) f B ©
2R & @ ¢ @
Accounts Date & Time Software Speech Startup Disk Universal

Update Access

Under Personal, click the !1 icon.

eoon System Preferences
[« »|[ showall | Q
Personal
e i oy
Ry B 6 @
Appearance Dashbol@rd & Desktop & International Security Spotlight
Expodé Screen Saver
Hardware
Q @B ¢ <
o |- y 7) = %
CDs & DVDs Displays Energy Keyboard &  Print & Fax Sound
Saver Mouse
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The Desktop and Screen Saver window should open to the
Desktop options.

(@00 Desktop & Screen Saver

[« »|[ showall | Q

]

{ Desktop | Screen Saver

Solid Gray Light

g‘ Apple Images
(7 Nature

lr,. Plants

[ Black & White
[ Abstract

) Solid Colors
(=) Pictures Folder

tr, Desktop Pictures

[ Choose Folder...

A

[ Change picture: every 30 minutes s f Random order

@

Tip: /£ the L2k | putton jsn't highlighted, click it
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4. Click the icon for the Nature folder.

@ Apple Image
< g» Nal*
(2 Plan

}I F | | Black & White

| 2 | Abstract

) Solid Colors

"';i Pictures Folder
_ Desktop Pictures
7 Choose Folder...

:'Iz
}
|
| =

Several images should appear on the right side of the window.

--ﬁ@

S. Click your favorite image.

Your Desktop image will change to the image you have selected.
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Click the

Show All

button.

Q,P(

G Desktop & Screen Saver
[ 4( = ] [ Show‘\u Q
AN

v

tLBesktop—+ Screen Saver ‘

————————
Water

[ g‘ Apple Images
@ Nature
Lr; Plants
[ Black & White
[ Abstract

) Solid Colors

Lr,;; Pictures Folder
[ Desktop Pictures
[ Choose Folder...

[ ] Change picture:

1

every 30 minutes = Random order

B el T
== e
-

@

You will see all of the System Preferences again.

Leave this window open for the next task.
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Change screensaver

1 = Under Personal, click the E" icon.

The Desktop and Screen Saver window should open.

2.  Click the LScreen Saver |y t0n to view the options.

e o Desktop & Screen Saver

| <« » || ShowAll | Q

! Desktop |

~

Screen%aver |

3. Click the Flurry icon.

' Desktop = Screen Saver

Sc Preview
f;_‘,. Computer Name B
< @. Flug
‘../‘
ey Cosmos
foy Forest

#oy iTunes Artwork
foy Nature Patterns
r;_';, Paper Shadow
% RSS Visualizer

A Spectrum

") Use random screen saver ( options... ) (

CUSTOMIZING YOUR SYSTEM
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4.

134

< Quit System Preferences . 3#Q ]
mm

An example of the screen saver will appear on the right side of
the window.

" Desktop | Screen Saver )

Screen Savers Preview

oy Computer Name
@ Flurry

@ Abstract

7oy Beach

’Q_d Cosmos
@ Forest

?;4 iTunes Artwork
?;4 Nature Patterns
?@, Paper Shadow
% RSS Visualizer

A Spectrum

[l Use random screen saver l\ Options... ) \ Test )

On the Menu Bar, click System Preferences, then Quit System
Preferences.

G’ T T Edit View Window Help
[

About System Preferences Desktop & Screen Saver

Services = L Q

Hide System Preferences 3H
Hide Others \C3H r " Desktop | Screen Saver }

_—

System Preferences should close.

CUSTOMIZING YOUR SYSTEM



Add/remove items from the Dock

-\
1. Click and drag the ﬁi icon out of the Dock, onto the Desktop.

@ Finder File Edit View Go Window Help <) Wed 10:35AM &

MACITOSHIHD)
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2. Release the mouse button.

)
The @ icon will disappear, and the application will no longer be
included in the dock.

@ Finder File Edit View Go Window Help 4) Wed 10:37AM

{VACINtOSH L)

Tip: 7he application itself will still be located in the Application
folder, and can be added fo the Dock again.
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3. Clickthe ‘, icon in the Dock.

4. When the Finder window appears, open the Applications folder.

J——— | A Applications
— _ p
2= O Q
| " &
Address Book AppleScript Automator
Calculator Chess Dashboard
= & b
& o
Dictionary DVD Player Font Book
iCal iChat Image Capture

25 items, 32.16 GB available —
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5. Click and drag the icon onto the Dock.

@ Finder File Edit View Go Window Help <) Wed 10:39AM &

i

| A Applications S

alh =m|| %) Q

A A

@ Network |

g Macintosh HD ;I Address Book Applescript Automator

E Desktop ; g Q

‘[‘mr macuser g

L E Calculator Chess Dashboard

ﬁ Documents | g E i &
oL | e (4

H Movies Dictionary DVD Player Font Book

\ iChat Image Capture
P

1 of 25 selecté 32.16 GB available —

LOBOOL IO«

alr

2
a
= . i
"
w
|'||n { TR {1 NN W N L TERRIN (RIR A0

6- Release the mouse button.

The icon should now be located in the Dock.

KOEeOLna

~—_
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Practice

Remove the

Remove the

-
Add the | &

icon from the Dock.

" © licon from the Dock.

icon to the Dock.

Add the |- =

icon to the Dock.

Close the Applications window.

CUSTOMIZING YOUR SYSTEM
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Change the Dock

’

1 . On the Menu Bairr, click the ‘ icon.

2. When the Apple Menu appears, click System Preferences...

The System Preferences window should open.

3. Under Personal, click the icon for the Dock.

e0n System Preferences

[q p”ShowAll] Q

Personal

=

Appearance Dashboard & Desktop'\§

& © Q

fternational Security Spotlight

Expose Screen Save
Hardware
& = © = A
Y = ) -
CDs & DVDs Displays Energy Keyboard & Print & Fax Sound

Saver Mouse

Internet & Network

® ® Q

Network QuickTime Sharing

System
) . & % +
R & @ § 2 @
Accounts Date & Time Software Speech Startup Disk Universal

Update Access

The Dock window should open.
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Next to Position, click the L*" | button.

Minimize using: | Genie Effect Q

®on Dock
[« » || showall | Q
Dock Size: 6
Small Large
! Magnification: - .
Min Max
Position on screen: () O]
Left Bottom

The Dock should move to the right side of your screen.

@ System Preferences Edit View Window Help

4) Wed1:31PM

@eeo Dock

[« »|[ Showall Q

-

Dock Size: . 6 .
Small Large

" Magnification:
Min Max

see oy "
Position on screen: (_ L 8

Left Bottom Right

Minimize using: = Genie Effect lB:

# Animate opening applications

) Automatically hide and show the Dock ®

-

.

WO . OBETFODOESE
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m
A

Click the Lttm] button.
’6 o0 Dock
(<« » [ showau | CY )
Dock Size: 8
Sr:'lall l.alrge
] Magnification: =
Min Max

Position on screen:

Left

)
R
Bottdm

Minimize using: LGenie Effect :3}

The Dock should move back to the bottom of your screen.

@ System Preferences Edit

View Window Help

4) Wed1:31PM @

Minimize using:

s

KBEROOLIEA

eon Dock 5—
[« »|[ showal | CY u
Dock Size: s
Sr:'lall Lalrge
[ Magnification: —
Min Max
Position on screen: (O ® O

Left Bottom Right

Genie Effect E'

EAnimate opening applications
) Automatically hide and show the Dock

@

< QW

Y
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Next to Dock Size, click and drag the slider to the left.

e6o0 Dock

[« » | showan | Q

Dock Size: -—8
I +—

Small Large
I Magnification: v
Min Max
Position on screen: () ® O

Left Bottom Right

-

Minimize using: 1Genie Effect |§

The Dock should shrink in size.

eeo Dock i_
[« »|[ showall Q

Dock Size: —@

1
Small Large

[ Magnification:

Min Max
Position on screen: () ® O

Left Bottom Right

Minimize using: = Genie Effect l-:-]

EAnimate opening applications
) Automatically hide and show the Dock @

KQBEOON/ DA KW

@ System Preferences Edit View Window Help 4) Wed1:33PM @
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Click and drag the slider back to the right.

—

Minimize using: :Genie Effect %

e 6N Dock
(< » ][ showail | Q|
Dock Size:
] ' I
Small Large
I Magnification: v
Min Max
Position on screen: () ® O
Left Bottom Right

The Dock should return to its original size.

@ System Preferences Edit View Window Help

<) Wed 1:34PM @

ry

@e6eo Dock
[« »|[ showal
Dock Size: 8
Small Large
[ Magnification: —
Min Max
Position on screen: () (O] O
Left Bottom Right
Minimize using: = Genie Effect F—:a
EAnimate opening applications
) Automatically hide and show the Dock @

KDEOOWIRA: W

Close the System Preferences window.
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Practice:
Customizing Your System

1. Change your Desktop background to the Ladybug image.

N

Change the Desktop to a solid color.

3. Change the Desktop background or color back to what they were
before.

- Change the Screensaver to the beach scene.

- Change the Screensaver to the forest scene.

4
S
6. Change the Screensaver back to what it was before.
7.  Add TextEdit to the Dock.
8. Remove TextEdit from the Dock.

9

= Change the position of the dock to the left side of the screen.

10. Change the position of the dock back to the bottom of the
screen.

1 1 = Close all windows.
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Using the Web

In this section, you'll learn how to:

e Connect to the Internet

View a web site

Search the web

Save a favorite web page

Set your own homepage

View a favorite web page

Change browser text size
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Connect to the Internet

Internet service

Before beginning this section, make sure you have an Internet
Service Provider and your computer is wired for the Internet, either by
dial-up modem, DSL, or cable service.

The Help menu may be useful in connecting to the internet.

1. Open the Finder.

2. Open System Preferences.
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3.

In the Internet & Network pane, click Network.

Personal

= B - . o
Appearance Dashboard & Desktop & Dock International Security Spotlight

Exposé Screen Saver

Hardware

1 | : S ﬁ f
CDs & DVDs Displays Energy Keyboard &  Print & Fax Sound

Saver Mouse

Internet & Network

] c

.Mac Netw&k QujtkTime Sharing

System
) . & b =
R & @® § £ @
Accounts Date & Time Software Speech Startup Disk Universal

Update Access

The Network window should open.

It will show choices for Built in Ethernet and Internal Modem
and tell you which one is connected.

Tip: /f you are not connected and need help, click the
( Assist me...

N

button. It will walk you through the steps fo get

connected.

Close the Network window.

Close System Preferences.
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@

On the Dock, click the icon.

L@OLIna

' 6

%

You should be connected to the Internet. The home page that

appears may be different from the one below:

en0on Apple - Start

[]http:waw,apple.com,fstartpagef

EE - Q( Google

[0 Apple (68)y Amazon eBay Yahoo! News (270)v

Store
Hardware

—&-—

Hot News  Switch

I iPod + iTunes T Mac

Software  Maded4Mac Education Pro  Business

IQuickTimeI Support X Mac 0S X |

Developer Where to Buy

The new iPod

Top Stories

October 19, 2005

xmL] Subscribe to Hot News RSS October 19, 2005 12:31 PM PDT

Download iTunes 6

Buy and download
aver 2,00

0

iTunes Video Exclusive

Get a 60-day free trial

Internet

Essentials for =
)\EE]!.' ]I‘lll‘DI_iu{.‘i.‘.‘i Aperture ) ) . your Mac
The firct allin.one noct nenduction tonl that neovidec svarything

Close the Safari window.

USING THE WEB




View a Web site

1 . On the Dock, click the @ icon.

The Safari window should open with your home page showing. It
may look different from the one pictured below:

en0on Apple - Start
[“Inttp:/ /www.apple.com/startpage/ GEY 2(Q- Google

[l Apple (68) Amazon eBay Yahoo! News (270)¥

_r . T Store IiPod+iTunesr Mac Y QuickTimeT Support X Mac 0S X | ﬂi

Hot News Switch  Hardware  Software MadedMac Education Pro Business  Developer Where to Buy

Download iTunes 6

Buy and download
aver 2.00(

&3

The new iPod

iTunes Video Exclusive

Top stries (Mac
XML Subscribe to Hot News RSS October 19, 2005 12:31 PM PDT Get a 60-day free trial
October 19, 2005 Internet P~ i
Essentials for 3
Apple ]n;rnd_ uces Aperture . ) . your Mac
The firct allin.one nost nroduction tool that nrovides sverithing

Tip: Safari is a type of application, called a browser, used for
viewing web sites. Other browsers include Internet Explorer,
Netscape, and Firefox.
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Click anywhere in the Address Bar.

600 “Apple —Star__
W @R R(a- Coogle

[0 Apple (68) Amazo

[ D - B G . )
| [ ¢ T Store I iPod + iTunes r Mac Y QuickTime I Support X Mac 0S X
Hot News Switch  Hardware  Software MadedMac Education Pro Business  Developer Where to Buy

Download iTunes 6

Buy and download
over 2,000

J

The new iPod

iTunes Video Exclusive

Topsories CMac

XML] Subscribe to Hot News RSS Octobe ), 2005 12:31 PM PDT Get a 60-day free trial

October 19, 2005 Internet P
Essentials for
Apple Introduces Aperture your Mas

The firet allinone noct nradinction tonl that neovidec svervthing

v

The text in it should be highlighted.

e 0o Apple - Start

E] @ u] [ http: / /www.apple.com/startpage/ [RSS|

Tip: /f the text is not highlighted, click inside the Address Bar at
the end of the line, then drag back over it to highlight it.

Type:

www.visibooks.com

e 00 Apple - Start

| 4. > |&] [i}  www.visibooks.com| RSS|
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4. Press the ENTER key on your keyboard.

After a moment, the Visibooks web site will be visible.
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Practice

1. In Safari, visit the web site at:

www.weather.com

2. Visit www.cnn.com.

Leave Safari open for the next task.
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Search the web

1 . Go to:

www.google.com

0006 Google
|Glhttp:  jwww.google.com/ a(Q~ Google )

1 Apple(68)v Amazon eBay Yahoo! News (270)¥
( ;O O 8 [e

Web |Images Groups MNews Froogle LocalNew! more»

| Advanced Search
Preferences

Language Tools

( Google Search ) { I'm Feeling Lucky )

Advertising Programs - Business Solutions - About Google

©2005 Google

2. In the Google search box, type:

Apples

Groups News Froogle LocalNew! more»

Advanced Search
Preferences

Language Tools

Apples|

'_/Google Search\_ "_'l'm Feeling Lucky )
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3. Press the ENTER key on your keyboard.

After a moment, a list of search results should be visible in the
browser window.

Sy Apples - Google Search
@ . |G]http [ /www.google.com/search?hl=en&q=Apples&btnG=Coogle+Search 'va Google

_Appla(68)v Amazon eBay Yahoo! News (270)v

Web |Images Groups News Froogle LocalNew! more »

Google == =) e

Web Results 1 - 10 of about 24,200,000 for Apples [definition]. (0.11 seconds)

Washington Appl mmission Sponsored Links

Apple varieties, history of the association, health and nutrition information, facts, kids' Appl

section, recipes, grower profiles, map of growing regions, ... Apples . .

www.bestapples.com/ - 11k - Cached - Similar pages Products and information about
Apples.
eBay.com

Just for Kids

Copyright® Washington Apple Commission Legal Notice | Terms of Use. Contact Info:
Phone: 1.509.663.9600 Translate this Site ...

www.bestapples.com/kids/ - 12k - Cached - Similar pages

Apples & More

Links to various apple related items, and lists of apple related facts, compiled by the
University of lllinois extension.

www.urbanext.uiuc.edu/apples/ - 7k - Oct 17, 2005 - Cached - Similar pages

Apples & More-Preserving Apples

Fact sheet explaining how to prepare apples for freezing or canning, also recipes for syrup for
preservation, preserving without sugar, recipes for chutney ..
www.urbanext.uiuc.edu/apples/preserving.html - 16k - g:_'-l_d_m_q Similar pages

I Merg rociilte frrm wanany pirhanawt i arie

NI

4. Click the first link in the list of search results.

B O ¢ i '— Apples - Google Search

ple (68)y Amazon eBay Yahoo! News (270)v
Web Images Groups News Froogle LocalNew! more»

Advanced Search
GO Ogle Apples (Search) Brforences

Results 1 - 10 of about 24,200,000 for Apples [definition). (0.11 seconds)

Sponsored Links

Apple varieties, history of the assdciation, health and nutsition information, facts, kids' Appl
ection, recipes, grower profiles, map of gromngr e Products and information about
a les.com/ - 11k - Cached - pages Apples

for Ki eBay.com
Copyright® Washington Apple Commission Legal Notice | Terms of Use. Contact Info:
Phone: 1.509.663.9600 Translate this Site ...

www.bestapples.com/kids/ - 12k - Cached - Similar pages
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Save a favorite web page

1.

Apples| /

On the Menu Bar, click Bookmarks, then Add Bookmark.

000

" Safari File Edit View HistoryWindow Help

ow All Bookmarks

{ 4 > ] [c] [-I-] Bhttp:{}m.best@s.cj

Add Bookmark...
Add Bookmark Folder

Click in the Name box.

Type:

Apples

[I1 Apple(®9 v Amazon eBay Yahoo!

e for the bookmark,
ere to keep it.

[=] Bookmarks Bar |2
( Cancel ) ( Add )

™ Y
Click the m button.

Type a name for the bookmark,
and choose where to keep it.

Apples

" &) Bookmarks Bar E!\

ooy G
e X

|=] Bookmarks Bar
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The bookmark Apples should appear in the Bookmarks Bar
directly below the Address Bar.

Washington State Apple Commission
_ 3 http: / /www.bestapples.com/

Q- Google

© Home © Planning a Visit

s

APPLE VARIETIES | HEALTH & NUTRITION RECIPES & MORE CORE FACTS MEET YOUR GROWER JUST FOR KIDS

%

e

“ Order Point of Sale Online

Click here to see what's available.
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Practice

1. In Safari, search the Web for:

cats

2. When the search results appear, click one of the links to go to
the site.

3. Save this site in your Bookmarks Bar.

Keep this window open.
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Set your own home page

1 . On the Menu Bar, click Safari, then Preferences.

mﬁle Edit View History Bookmarks Window Help
8 _

l Cats @ nationalgeographic.com

geographic.com/cats/

Yahoo! News (279)v

Private Browsing
Reset Safari...
Empty Cache...

Services
Hide Safari
Hide Others 3#H

Show All PLA\'\ FoR PERFECTION

- : “THE CAT |5 ONE ANIMAL NATURE
Quit Safari PRETTY MUCH GOT RIGHT THE FIRST
TIME AROUND ... THE STORY OF

=
2. When the Preferences window appears, click the le==| icon.

O OQ General (=]
LN @ vd [l § &
Ceneral Appearance Bookmarks Tabs RSS  AutoFill Security Advanced
Default Web Browser: = &) Safari Iy
New windows open with: " Home Page by

Home page: http://livepage.apple.com/

( Set to Current Page )
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In the Home Page box, type:

www.yahoo.com

(® OO

General —

L8] ba

6 w7 g

General Appearance Bookmarks Tabs RSS

AutoFill Security Advanced

New windows open wi

Default Web Browser:

Horke page:

f@ Safari @

www.yahoo.com /

age )

Your screen should look like this:

(e N0

General (=)

8] b

@ =

General Appearance Bookmarks Tabs

8 @

AutoFill Security Advanced

Default Web Browser:

New windows open with:

Home page:

Save downloaded files to:

Remove download list items:

Open links from applications:

" @ Safari 9

" Home Page ‘%]

www.yahoo.com

( Set to Current Page )

{ {@F Desktop ::j
)

" Manually

v Open “safe” files after downloading

“Safe” files include movies, pictures, sounds,
PDF and text documents, and disk images
and other archives.

® in a new window

(D in the current window
This applies to links from Mail, iChat, etc.
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window.

On the Toolbar, click the

icon.

Press the ENTER key on your keyboard, then close the General

Cats @ nationalgeographic.com

)nttp //www.nationalgeographic.com/cats/

[+ ]
3
w0
-4
=
>
— |
o
=
=
E

The Yahoo home page should now appear.

(SN NG) Yahoo!
@ w7 http: / /www.yahoo.com/ A(Q~ Google [5)
[0 cats Apples Apple(69)v Amazon eBay Yahoo! News (279)¥
) = 1
e G {
W B O YARHOO! o« w %
Finance i~ Music i~ Shopping i~ Mail My Yahoo! Messenger
Select Search Category: m Images | Video | Directory | Local | News | Shopping
Search the Web: ( Vahoo! Search ) :mvmréed
y

Yahoo! Travel -

Flights, Hotels, Cars, Cruises, Vacations, Last-Minute Getaways

- B Check your mail status: Sign In

Free mail: Sign Up

All Y! Services...

L o i Cl’ﬁ Introducing the

360° Horoscopes Movies Real Estate Citi Simplicity™ credit card
Autos HotJobs Music " Shopping i = 123

Finance Kids My Yahoo! Sports b | = We get that you didn't
Games Local News Travel 1 wwh’m“x
GeoCities Mail People Search TV

Groups Maps Personals Yellow Pages Citi Simplicity - Ad Feedback

Health Mobile Photos

6:51pm, Wed Oct 19

Yahoo! Search Marketing

Drive more
customers to your
site for as little as

* Hurricane Wilma aims for Central America

» Saddam trial adjourns as defense buys time
» Senators say Miers' answers inadequate

» Texas court issues warrant for DeLay

« Drug effective against early breast cancer

* Hormone may play role in how people interact

Open “http://us.ard.yahoo.com/SIG=12kfei78v/M=331250. ?080901 8015?02 35 1.F“I|rlp //my.yahoo.com/" in a new window behind the current window

h\q»{

Tip: /fyou can’t see the

N}

icon, click History, then Home on

the Menu Bar.
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View a favorite web page

1.

On the browser’s Bookmarks Bar, click Apples.

e 0o Yahoo!
[ . ]/[/C’H -+ http: / /www.yahoo.com/

/

<
(mA)| (:ats M?A}ple (69)¥ Amazon eBay Yahoo! News (281)v

Finance i~ Muslc i~ Shopping i~ Mall

jrh" YAHOO.’

The page that you bookmarked should now appear.
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Change browser text size

164

1.

On the Menu Bar, click Safari, then Preferences.

When the Preferences window appears, click the

m File Edit View History Bookmarks Window Help <)
.re ( About Safari Washington State Apple Commission
B astapples.com/ “/Qv C
= Preference e eBay \Yahoo! News (281)~

Block Pop-Up Wihdows 3K

Private Browsing

Reset Safari...

Empty Cache... X 3#E

Services >

Hide Safari %H y

Hide Others NIEH PSS -

Show All

I Quit Safari e
AP RECIPES & MORE | COREFACTS | MEET YOUR GROWER | Ju|

[d

Appearance

(e N ?/ \ General

GLQ 0 @7 g
ener Appear‘_nce

Bookmarks Tabs RSS AutoFill Security Advanced

ult Web Browser: | @ Safari 9
New windows open with: | Home Page 3

Home page: http://www.yahoo.com/

( Set to Current Page )
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3.  Next to the Standard Font box, click the [__Se'e<t-- | putton.

(@ OO Appearance =)

NCECEEY

General  Appearance Bookmarks Tabs RSS AutoFill Security Adva

Standard font: Times 16

Fixed-width font: Courier 13

v Display images when the page opens

Default Encoding: | Western (ISO Latin 1) =3 ®

4. In the Font Size box, type:

0006
iM[zM[TCD ] [ T
Collections Family

All Fonts Silom
Favorites Skia
Recently Used STFangsong
Chinese STHeiti
Classic STKaiti
Fixed Width STSong

Fun Symbol
Japanese ‘2 Thonburi
Korean v Times
|nckialas T~ Search

5. Close the Font window.

6. Close the Appearance window.
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7. On the Toolbar, click the & | icon.

The Yahoo home page should now appear with a larger font
size.

Yahoo! ===
i + ;Y?hnp:f,-‘www.-,!ahon.cam! ‘(_Q' Google

ples Apple (69)v Amazon eBay Yahoo! News (288)v

s ) =
7 0 W YaHOO! o
Finance i~ Music i~ Shopping i~ Mail My Y
Select Search Category: m Images | Video | Directory | Local | News | Shopping
Search the Web: | | (yahoot seareh )
Yahoo! Travel - Flights, Hotels, Cars, Cruises, Vacations, Last-Minute GetawayJ|
(’j\ Check your mail status: Sign In Free mail: Sign Up
360° Horoscopes Movies Real Estate | vzl
Autos HotJobs Music " Shopping UL L b R
Finance Kids My Yahoo! Sports
Games Local News Travel i
GeoCities Mail People Search TV Citi Simplicity - Ad Fe¢
Groups Maps Personals Yellow Pages
Health Mobile Photos FEp Iinhe;News
* Hurricane Wilma lashes C
Yahoo! Search Marketing + Saddam trial adjourns as (4
______________________________________ ( an:esls_Sadda[tL'§ :\fil;'

8. Quit Safari.
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Practice: Using the Web

1.

View the Web site at:

www.cnn.com

Search the web for red cars.

Save one of the search results in your Bookmarks Bar.

Set www.google.com as your homepage.

Access the site on red cars that you saved in your Bookmarks
Bar.

Print the page.

Change your browser text size to 30.

Quit Safari.

USING THE WEB
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Using E-mail

In this section, you'll learn how to:

e Configure an e-mail account

Send an e-mail message

Check for new mail

Reply to a message

Send an attachment

Delete messages
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Configure an e-mail account

1. On the Dock, click the e icon.

1OOWIIRQA:¢ G

Tip: 7he first time you use the email application, a window will
open with email settings.

Type in the appropriate email settings supplied by your Internet
provider.
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In the General Information screen, select the type of email
account in the Account Type box (most people have POP).

Then type in your email address.

-

06O New Account

General Info

Account Type: ( @ POP

Account Description: POP Account

Full Name: Mac User

Email Address: user@visibooks.com

@ ( Continue )
Click the |€_Continue 3 1) ;110
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S.

In the Incoming Mail Server screen, enter the name of the mail
server used to download your email.

It’s probably something like pop.yourserver.com or
mail.yourserver.com.

Tip: /f you don’t know the address of your incoming mail server,
contact your Internet Service Provider or network administrator.

Then type in your email account user name and password.

06O New Account

Incoming Mail Server: mail.visibooks.com
Example: mail.example.com

User Name: user@visibooks.com

Password: esssss

s

L -‘t’,|?‘\‘)

@ ( Cancel ) ( Go Back ) G—Gontinue—’

Click the |€ Continue ) |, +t0n.
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In the Outgoing Mail Server screen, type the Web address of the
server used to send out your e-mail.

It’s probably something like smtp.yourserver.com or
mail.yourserver.com.

Tip: /f you don’t know the address of your outgoing mail server,
contact your Internet Service Provider or network administrator.

You'll probably want to click the Use Authentication box.

06O New Account

Outgoing Mail Server

aing Mail Server: mail.visibooks.com B
Example: smtp.example.com

@ Use Authentication

User Name: user@visibooks.com

Password: esssee

@ (_ Cancel ) ( GoBack ) € Continue )

Click the € Continue ) 1y 1101,
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9. When the Account Summary screen appears, click the

(€ Continue ) 1y tton.

T

06O New Account

Account Summary

Account Description: POP Account
Full Name: Mac User
Email Address: user@visibooks.com
User Name: user@visibooks.com

Incoming Mail Server: mail.visibooks.com
SSL: off

Outgoing Mail Server: mail.visibooks.com
SSL: off

— sack(@
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Tip: /f you want to delete an account, such as a previous
owner's account, do this.

On the Menu Bar, click Mail, then Preferences.
In the Accounts window, click the Accounts icon.

Click the account you wish to delete. At the bottom of the
window, click thel —

button.

e 06 Accounts (=)

B]l@ B D &= [ £ o

General Accounts Junk Mail Fonts & Colors Viewing Composing Signatures Rules

Accounts - {Account Information | Mailbox Behaviors = Advanced -

£ POP Account
POP

Account Type: POP

Description: POP Account

Email Address: user@visibooks.com

Full Name: Mac User

Incoming Mail Server: mail.visibooks.com

User Name: user@visibooks.com

Password: eee

Outgoing Mail Server (SMTP): | mail.visibooks.com:user@ |4

{ Server Settings... )

Gy 5

When the Remove Account window appears asking if you are
>
sure you want to remove the account, click the m button.
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Send an e-mail message

1.  Inthe Mail window, click the "] putton.
o6 Inbox (0 messages)
o Q
_ t I k. ply Reply All Forw ﬁk Get Mail Search
= . * ® From Subject Date Received
Sent
+ | - 1]
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In the New Message window, type:

youremail@yourdomain.com

in the To box.
006 New Message O
D OB @@ O

olors Save As Draft

Send “hat  Attach Address Fonts

To: user@visibooks.com|

(Replace youremail @ yourdomain.com above with your real
email address. For example: yourname @yahoo.com.)

In the Subject box, type:

First Message

®006 First Message (@)

Send Chat Attach Address Fonts Colors Save As Draft

To: user@visibooks.com

(=¥ Subject: First Messagel )
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4. In the blank message area, type:

This is my first email message.

®O006 First Message

Send Chat Attach Address Fonts Colors Save As Draft

To: user@visibooks.com

e

,E——Sub]mw
< This is my first email message|
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Click the .=/ putton.

.O e 6 First Message
P e Gem e &

Send Chjt Attach Address Fonts Colors Save As Draft

\_/To: user@visibooks.com

e

E Subject: First Message

This is my first email message.

Your message should be sent.
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Practice

1. Compose an email message.

2. Send it to your best friend’s email address.
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Check that your message was sent

1 . In the Mailbox window, click the Sent folder.

o6 Inbox (0 messages) (=]
[S) [ 4 a

uni Reply Reply All Forward New Get Mail Search
e & From Subject Date Received A

Your first message should be in the list of messages.

®o6 Sent (2 messages) (@)
Q _ » € Q
Delet Junk Reply Reply All Forward New  Get Mail Search
J-. . shject Date Sent
| user@visibooks.com First Message Today 3:13 PM
friend@visibooks.com message for my best friend Today 3:15 PM

Keep this window open for the next task.
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Check for new mail

1. Click the [L—_1 button.
e 606 Sent (2 messages) =
o I ! 4 e Q
Delet Junk Reply Reply All Forward New Get%il Search
[ Inbox e ® To Subject Date Sent
R user@visibooks.com First Message Today 3:13 PM
friend@visibooks.com  message for my best friend Today 3:15PM
2. In the left pane, click the Inbox icon.
e 66 Sent (2 messages) =
! ! d e Q
g ink ly Reply All Forward New  Get Mail Search
®  ®\To Subject Date Sent
user@visibooks.com First Message Today 3:13 PM
friend@visibooks.com message for my best friend Today 3:15 PM

It should contain the message titled First Message that you sent
to yourself.

Tip: /t may take a few minutes for this message to arrive from
your email server.
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3.

Double-Click the message to view it.

066

Inbox (1 message) =
O ) & e € &P <
/D-a.-'r.‘e——.r.nm Reply  Repty Ai—Fessac New  Get Mail Search
- ( | e ® From | Subject Date Received Af
1 ¥ D - - Macﬁser First Message Today 3:14 PM
1/ Sent
It should look like this:
e 606 First Message — Inbox O
COEEMD E R S &
Delete Junk Reply Reply All Forward Print
From: Mac User
Subject: First Message
Date: October 20, 2005 3:13:47 PM EDT
To: user@visibooks.com
This is my first email message.
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4.

Close the message.

CXS) ? First Message — Inbox
\R‘ N &« T« > N
Delete  Junk Reply Reply All Forward Print

From: Mac User
Subject: First Message
Date: October 20,2005 3:13:47 PM EDT
To: user@visibooks.com

This is my first email message.
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Reply to a message

1.

Click the First Message message.

006 Inbox (1 message) o
COERMS ESIKSICS @ D
_—Delete  junk —=Reply ReplyAll Forward  New  Get Mail Search
- / ® & From Subject Date Received 4|
| ¥ B Mac User p.
T/ Sent
From: Mac User
Subject: First Message
Date: October 20, 2005 3:13:47 PM EDT
To: user@visibooks.com
This is my first email message.
+ | f- 1l

2.  Click the l_>=|button.
006 nbox ssage) e
O TR (S ) @D @ @&
Delete ) New  Get Mail Search
[\, * 9 From Subject ‘Date Received a]
| ¥ Banae Mac User First Message Toda 3:14 PM
7/ Sent
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3.

< [|=v| Subject: Re: First Message

/EL_QuWe: First Message

When the Reply message window appears, click in the main
message area.

®06 Re: First Message o

Send Reply All Chat  Attach Fonts Colors Address Save As Draft

To: Mac User

Cc:

IX
%QO, 2005, at 3:13 PM, Mac User wrote:

This is my first email message.

W
Then type:
This is my reply.
®006 Re: First Message =)

o & ® @& @ @ & 5

Send Reply All Chat Attach Fonts Colors Address Save As Draft

To: Mac User

e

This is my reply
On Oct 20, 2005, at 343 PM, Mac User wrote:

| This is my first email message.
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In the Subject box, select the existing text and replace it with:

Reply to my message

®@006 Reply to my message

& O 6O @ @ @
Send Reply All Chat Attach  Fonts

Colors

\ E > Qy
Address Save As Draft

To: Mac User

G
=v| Subject: Reply to my message|

D)

This is my :
On Oct 20, 2005, at 3:13 PM, Mac User wrote:

| This is my first email message.

USING E-MAIL
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B.  Click the .= putton.

®06 Reply to my message
/’\.‘_/ o)) ﬁ (f_‘/}j\ /;';-'._'l\ /Q‘\ /EJ‘\ {'I___r‘\

Send All Chat Attach Fonts Colors Address Save As Draft

To: Mac User

Ge:

|=v| Subject: Reply to my message|

This is my reply.
On Oct 20, 2005, at 3:13 PM, Mac User wrote:

This is my first email message.

Leave this window open for the next task.
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Send an attachment

1 . On the Toolbar, click the L_=—_1 button.

006 Inbox (2 messages)

@ ) = (-/

Delete  Junk Reply Reply All F}wv\ard e

Search

2. In the New Message window, where the cursor is blinking, type

your own email address in the To box.

®006 New Message

|u| |_—|

Colors Save As Draft

3. In the Subject box, type:

Message with attachment

®006 Message with attachment

DO D@D C
Send Chat Amach Address Fonts Colors Save As Draft

To: Mac User

Subject: .Message with attachment]

USING E-MAIL
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4.

S.

190

In the blank message area, type:

This email message has an attachment.

®006 Message with attachment

Send Chat Attach Address Fonts Colors Save As Draft

To: Mac User

(el

This email message has an attachment|

On the Toolbar, click the -2 icon.

®06 Message with attachment
|V S ;k P & & o
Send Chat  Arttac Address Fonts Colors Save As Draft

To: Mac User

GG
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6. When the Insert Attachment window appears, click the
Documents folder.

DO 6 Message with attachment (=
(<] ») f§ P"EEH*] TJ Documents I%J Q search
@ Network [;-_* MyFiles o

'« Peacocks
‘o Schedule

3 Macintosh HD %
‘e Thanks copy 1

u Desktop

*’3_" macuser
K Applications 7=
_hb Documents >

“‘ MOVIEN:
é Music

@ Pictures

() Send Windows Friendly Attachments

( Cancel ) (Choose File)
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Click the file Schedule.

) Em

" [ Documents B9 (Qsearch )

@ Network
= Macim@

u Desktop\
@ macuser

A Applications |~

ﬁ" Documents

Peacocks

Schegule
Thar’; copy 1

oV o & |

/

) Send Windows Friendly Attachments

( cancel ) (Choose File)
y/

Click the [(Choose File)| 1) 1o

@ Network

u Desktop
@ macuser

A Applications |~

ﬁ" Documents
s .

‘<« » ! '=}m) [ Documents WY (Qsearch B
2 MyFiles > M
— ) ‘4 Peacocks A
é Macintosh HD B Schedule F“:LE';%E
"« Thanks copy 1 eyl
w
Name Schedule
Size 4 KB N
Kind Rich Text |4
Format (RTF) |¥
1l document I

) Send Windows Friendly Attachments

¢ Cam{il ) (Ehom%lg) ;
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The file will now be visible in the message window.

& O@D®e W

Chat Attach Address Fonts Colors Save As Draft

®006 Message with attachment (@)

To: Mac User

£c:

Subject: Message witha)m_d;mtﬁﬁ%

This email message has an atlgchment. Schedule (0.5 KB)

Click the .=/ button.

/9 06 Message with attachment o

® L@ & @ ©
Sendk Chat

Attach Address Fonts Colors Save As Draft

\_/‘é Mac User

Ce:

=v| Subject: Message with attachment

=
-
This email message has an attachment. Schedule (0.5 KB)

USING E-MAIL

193



Delete messages

1. On the Toolbar, click the [~ button.

006 Inbox (2 messages) (=
CO-HH K=o @b @
Delete  Junk Reply Reply All Forward Get MNil Search
2.  Click the Inbox folder.
®o06 Inbox (3 messages, 1 unread) (=
CO=—> K=r<oro= @B E-p
Delete  Junk Reply Reply All Forward New  Get Mail Search
- | o ®\From ' Subject Date Received A
L=~ k o ) Mac User
e Mac User Reply to my message Today 3:29 PM
4 Mac User Message with attachment Today 6:56 PM
3. Click the message you sent yourself, titled Reply to my
message.
®66 Inbox (3 messages, 1 unread) (=
RS ESIKSRCS @H ©D @
Delete  Junk Reply Reply All Forward New  Get Mail Search
1\ | ® | ® From biect ‘Date Received A
Bl 7 : Mac User First Messag :
— Mac User Reply to my message pday 3:29 PM
4 Mac User MePsge with attachmen Today 6:56 PM
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With the message selected, click the @ button.

e66 \l‘l\box (3 messages, 1 unread) =
- N -~ > — — . Fmyr" - ~ _— oo
( M) KSR @ D @
Delée Juy Reply Reply All Forward New  Get Mail Search
= ]\L_Q_JFOT( Subject ‘Date Received 4|
[ ¥ Eae mll 5 Mac User First Message Today 3:14 PM
7 Mac User Reply to my message Today 3:29 PM
- Mac User Message with attachment Today 6:56 PM
From: Mac User
Subject: Reply to my message
Date: October 20, 2005 3:29:03 PM EDT
To: Mac User
This is my reply.
On Oct 20, 2005, at 3:13 PM, Mac User wrote:
This is my first email message.
+ | B~ 1}
The message should disappear.
006 Inbox (2 messages) o
i GSia» @ @ @
Delete  Junk Reply Reply All Forward New  Get Mail Search
o\ e ® From Subject ‘Date Received 4
[ ¥ Relas | 9 Mac User First Message Today 3:14 PM
=7 sent Mac User Message with attachment  Today 6:56 PM

Tip: Deleting a message from your Inbox moves it to the Trash

folder.
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5. Click the % folder.

006 Inbox (2 messages) o
D ESIKSED @ @ @
Delete  Junk Reply Reply All Forward New  Get Mail Search
e ® From Subject ‘Date Received 4|
| 9 Mac User First Message Today 3:14 PM
Mac User Message with attachment Today 6:56 PM

From: Mac User
Subject: Message with attachment
Date: October 20, 2005 6:56:00 PM EDT
To: Mac User
» & 1 Attachment, 0.5KB ( Save v )

ieh
-

This email message has an attachment. -
Schedule (0.5 KB)

Tip: /fyou don’t see the Trash folder, close the mail window and
reopen It.
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Click the message titled Reply to my message.

Trash (1 message)

O >

Delete  Junk

L

Subject

Mac User

Reply to my message

October 20, 2005 3:29:03 PM EDT
Mac User

From:
Subject:
Date:
To:

This is my reply.
On Oct 20, 2005, at 3:13 PM, Mac User wrote:

This is my first email message.

+ | fE- 1l

Click the @ button.

0066

Reply Reply All Forward New

Trash (1 message)
'K_ ) ‘\ - “= = /' L/_./f)
Dl Jupk”

&) ([

Get Mail Search

Subject
Reply to my message

& % From
Mac User

I:l Inbox

7/ Sent

‘Date Received 4|
Toda 3:29 PM

This deletes the message from your computer.

Quit the Mail application.
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Practice: Using E-Mail

198

Open the Mail application.

Open a new message, write something, and send the message
to yourself.

Check for new mail.

Open the message you sent yourself and reply to it.

Check for new mail.

Delete the first message you sent yourself.

Compose a new message to yourself and attach the Peacocks
file

Check for new mail.

Quit Mail and disconnect from the Internet, if applicable.
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Glossary

Apple Menu
The menu in the upper left corner of the Menu Bar that contains main
system actions. For example: System Preferences, Shut Down, Log Ouit.

Application
Software that allows you to perform a specific task using the computer. Also
called a program.

Attachment
Any file sent along with an email message.

Bookmark
A web address that is added to a web browser’s favorite list for future easy
access.

Burn
Permanently writing information to a compact disc.

Button
A raised, clickable shape with a word command in its center. When clicked,
it executes the command.

Copy
A command that duplicates selected information. It sends the information to
the Clipboard so you can put it somewhere else.

Cut
A command that removes selected information. It sends the information to
the Clipboard so you can put it somewhere else.

Delete
A command that permanently removes a file, folder, or information.
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Desktop
The background over which all windows are displayed.

Dock
The bar on the bottom of the Desktop that displays icons for applications.

File
A collection of information—under one name—that you can read, look at, or
listen to using a computer.

Finder
An application that lets you view files and folders on the computer.

Folder
A container for files on the computer. Also called a Directory. It works like a
manila folder in a filing cabinet.

Home page
The Web page that opens automatically when you start a Web browser.

iCal
An application that allows you to create calendars and “to do” lists.

iChat
An application used to send short real-time messages and files to other
computers.

Icon
A clickable picture.

iPhoto
An application used to view, organize, and edit photos.

iTunes

An application used to manage music and play internet radio on your
computer.
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Macintosh HD
The Macintosh Hard drive (HD) contains the operating system, applications,
files, and system preferences.

Mac OS X

Software that allows a computer to operate all its components, respond to
human commands, and run other applications. Known as an “operating
system.”

Memory
The working area of the computer where data and active applications are
loaded for use.

Menu
A list of commands that the user can choose from.

Menu Bar
A horizontal bar across the top of desktop that contains commands.

Minimize
To remove a window from the desktop—without closing it—by placing it in
the dock.

Paste
To place an item that has been cut or copied to a new location.

Quicktime Player

An application that plays movies and sound files.

Restore

To bring a minimized window out of the dock and back onto the desktop.

Safari
An application that allows you to view Web pages.

Save

A command that allows you to name and store a file so it can be retrieved
later.
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Save As
A command that allows you to rename and store a file so it can be retrieved
later.

Screen Saver
An application that displays pictures on your monitor while your computer is
turned on, but inactive.

Scroll
To move a window’s display horizontally or vertically to see all its contents.

Software
Instructions stored in the computer’s memory that allow you to give
commands to the computer and perform tasks with it.

System Preferences
An area of your computer that allows you to specify display, sound,
network, and other options.

TextEdit
An application used to create and edit documents.

Title Bar
The horizontal bar at the top of a window that contains the name of the
application and/or file being used in it.

Trash
A temporary storage area in computer memory used to keep deleted files
available until they’re permanently removed.

Window
An area of the computer’s video display containing a specific application or
file.
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Where to Get Visibooks

If you liked using this book, and would like to use more like it, visit:

www.visibooks.com

Visibooks offers more than 30 titles on subjects such as:

e Computer Basics
¢ Microsoft Office

e Desktop Linux

e OpenOffice.org

e Web Site Layout

e Web Graphics

e Web Programming

Visibooks: the simplest way to learn
and teach computer subjects.

Visibooks

www.Visibooks.com



